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1 Desktop shortcuts

The Telink 10T studio installer will create 2 shortcuts on the desktop:

+ Telink IoT studio : used to launch the loT Studio.
« Telink TC32 console : used tolaunch the development console for TLSR8, users can input commands

like tc32-elf-gcc and make init.

2 Different IDEs

The following 3 different IDEs will be referred to in this user guide:

+ Telink IoT studio : the IDE contains this document.
« Telink old IDE : the IDE list on this wiki page (IDE for TLSR8 Chips) for TLSR8 chips.
» Telink RDS IDE : the IDE list on this wiki page (IDE for TLSR9 Chips) for TLSR9 chips.

The above 3 IDEs have the following different desktop shortcut icons:

Telink 1oT studio:

s

AL | TR
» '\-\.\.:..:_."|||I|_.:|::._‘::...-E:..:

- T =

o =3
o PR ..o

;-")‘Z- o
IS

)

Figure 2.1: Telink 10T studio Icon

Telink old IDE:

Figure 2.2: Telink OId IDE for TLSR8 Icon

Telink RDS IDE:

Figure 2.3: Telink RDS IDE for TLSR9 Icon
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3 loT Studio or integrated tools

 Build TLSR8 Projects and SDK

» Import and build TLSR9 Telink RDS Projects and SDK

 Telink Windows BDT used to flash image for both TLSR8 and TLSR9

+ Telink libUsb version BDT used to flash image for both TLSR8 and TLSR9, still in beta phase.
» Jtag_Burn used to flash image for TLSR9 with JTAG

4 Project property difference between Telink RDS and
Telink loT studio

4.1 Ext HW DSP option

This option is used to configure whether to use the DSP and its libraries:

T Properties for B93 Driver Demo

type filter text

Resource
Builders
v Cf/C++ Build
Build Variables
Environment
Logging
Settings
Tool Chain Editor
C/C++ General
Git
Linux Tools Path
Project Natures
Project References
RISC-V Toolchains Paths
Run/Debug Settings
Task Tags
TC32 Loader
Validation
WikiText

This option would add

without the -1m and

Users can add the math and dsp

Settings

Configuration: |D25_Enable_N22_Demo [ Active ]

B Tool Settings &3 Toolchains B Devices

B Devices [J Container Settings  # Build Steps

@ Target Processor
2 Optimization
# Warnings
(# Debugging
w 83 GNU RISC-V Cross Assembler
(8 Preprocessor
(# Includes
(& Warnings
(# Miscellaneous
w 83 GNU RISC-V Cross C Compiler
(22 Preprocessor
(# Includes
(# Optimization
# Warnings
(# Miscellaneous

[JGenerate assembler listing (-Wa,-adhlns="$@.ls
[]Save temporary files (--save-temps Use with cau

verbase (-v)

Other compiler flags | -mext-dsp -mabi=ilp32f -c

[]Support ANSI Programs, same as RDS (-ansi)

[Code Coverage, same as RDS (--coverage)

(] Apply HW DSP options{-mext-dsp) I

Figure 4.1: DSP option in Telink 10T studio

-mext-dsp flagto cc and 1d , and also it would add
to linker in Telink RDS IDE. While the Telink 10T studio would only add

-lm and -ldsp flags
-mext-dsp flagto cc and 1d

-ldsp extra libraries flags. This makes the configuration more flexible.

libraries to linker specifically on the linker library setting page:

AN-22063002-E1
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*| Properties for B93 Diriver Demo

type filter text Settings

Resource
Builders
v CfC++ Build

Build Variables
Environment
Logging
Settings
Tool Chain Editor

C/C++ General driver

it (% Warnings m
Linux Tools Path & Debugging
w B3 GNU RISC-V Cross Assembler

Project Matures

Configuration: | D25_Enable_N22 Demao [ Active ]

) Tool Settings ®) Toolchains J Devices i Devices [ Container ¢

(% Target Processor Libraries (-])

(# Optimization

: (2 Preprocessor
Project References e

[;_-_/.'?* Includes
RISC-V Toolchains Paths

X . (# Warnings
Run/Debug Settings (2 Miscellaneous

Task Tags v B3 GNU RISC-V Cross C Compiler
TC’:’I’E Lf:uader (% Preprocessor
Validation = Includ
" (22 Includes
WikiText

(# Optimization
(% Warnings
(# Miscellaneous
w By GMU RISC-V Cross C Linker

i) _ Library search path (-L)
I (% Libraries n cspace loc/$iPro;

@ Miscellaneous

Figure 4.2: Add DSP libraries in Telink loT studio

4.2 -msave-restore and -msmall-data-limit

The Telink RDS IDE wuses the loT Studio built-in (default) value for both  -msave-restore and
-msmall-data-limit without options on configuration page, while the Telink IoT studio has a more
flexible configuration for these options.

Right now, users should use the Use toolchain default value option for TLSR9 chips.

AN-22063002-E1 10 Ver1.0.10
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Environment
Legging
Settings
Tool Chain Editor
C/C++ General
Git
Linux Tools Path
Project Natures

Project References

B Tool Settings 2 Toolchains M Devices

B Devices [ Container Settings Build Steps Build Artifact @; Binary Parsers @ Error Parsers

(# Target Processor
& Optimization
(2 Warnings
(% Debugging
~ &3 GNU RISC-V Cross Assembler
( Preprocessor

(& Includes

Architecture Toolchain default
Multiply extension (RVM)
Atomic extension (RVA)

None

Compressed extension (RVC)

RISC-V Toolchains Paths @ Warnings Integer ABI Toolchain default

Run/Debug Setings (£ Miscellaneous None

Task Tags ~ 8 GNU RISC-V Cross C Compiler . :

TC32 Loader ( Preprocessor Tuning Toolchain default

Valli‘datimn (2 Includes Code model medium (same as RDS)

vikiTet (% Optimization I B Use toolchain default value for RISC-V specific setting (will ingore the following -msave-restore and -msmall-data-limit setting]l

B Warni
& Warnings Small data limit 8

& Miscellaneous

~ i3 GNU RISC-V Cross C Linker Align Toalchain default (-mtune)
(% General O Small prologue/epilogue (-msave-restore)

(% Libraries

Force string operations to call library functions (-mmemcpy)
A Mizrellansnns

Figure 4.3: RISC-V specific option on Telink 10T studio

5 Toolchain

5.1 Toolchain information

The Telink loT studio contains several toolchains for TLSR8 and TLSR9:

+ Telink TC32 Cross Compiler with GCC version 4.5.1 (tc32-elf) for TLSR8 which is the same as the Telink
old IDE.

« Cross Compiler with GCC version 7.4 from Telink RDS IDE V3.2.3 for TLSR9 (D25F and N22 architecture)
chips

+ Cross Compiler with GCC version 10.3 from Telink RDS IDE V5.1.2 for TLSR9 (D25F and N22 architecture)
chips

+ Cross Compiler with GCC version 12.2 from Telink RDS IDE V5.3.x for TLSR9 (D25F and N22 architecture)
chips

5.1.1 Toolchain location

We assume that the Telink 10T studio is installed at location $IoTStudio :

 Telink TC32 Cross Compiler with GCC version 4.5.1 (tc32-elf-1.5) for TLSR8: $IoTStudio/opt/tc32/bin
+ Cross Compiler with GCC version 7.4 from Telink RDS IDE V3.2.3 for TLSR9 (D25F and N22 architecture)

chips

* N22: $IoTStudio/RDS/V3.2.3/toolchains/nds32le-elf-mculib-v5

* D25F: $IoTStudio/RDS/V3.2.3/toolchains/nds32le-elf-mculib-v5f

+ Cross Compiler with GCC version 10.3 from Telink RDS IDE V5.1.2 for TLSR9 (D25F and N22 architecture)
chips

* N22: $IoTStudio/RDS/V5.1.2/toolchains/nds32le-elf-mculib-v5

e D25F: S$IoTStudio/RDS/V5.1.2/toolchains/nds32le-elf-mculib-v5f

+ Cross Compiler with GCC version 12.2 from Telink RDS IDE V5.3.x for TLSR9 (D25F and N22 architecture)
chips

AN-22063002-E1 M Ver1.0.10
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* N22: $IoTStudio/RDS/V5.3.x/toolchains/nds32le-elf-mculib-v5
e D25F: S$IoTStudio/RDS/V5.3.x/toolchains/nds32le-elf-mculib-v5f

5.2 Select a different toolchain for TLSR9 projects

As only one toolchain is included for TLSR8, this section is only applied to TLSR9 chips.

To change the toolchain of a project, open the project properties, navigate to C/C++ Build -> Settings
-> Toolchains tab, and select the different one from the drop-down list:

Settings S g
Configuration: |UART Demo [ Active 1 v | | Manage Configurations.

1 Tool Settings & Toolchains Ml Devices M Devices [ Container Settings Build Steps Build Artifact Binary Parsers @ Error Parsers

TL32 ELF MCULIB V5F GCC12.2 (1
ITL32 ELF MCULIB V5 GCC122 (ri
Prefix: I TL32 ELF MCULIB V5F GCCl
ITL32 ELF MCULIB VI5F GCCT.
Telink TLSR9 D25F GCC 7 (1

RISC-V GCC/Newlil
RISC-V GCC/Linux
Archiver: RISC-V GCC/RTEM:

Hex/Bin converter: |CUstom (riscv64-unknown-nane-gec)

Figure 5.1: Select Toolchain

The listed toolchains are:

« TL32 ELF MCULIB V5F GCC12.2 : for D25F architecture chips, from RDS V5.3.x
e TL32 ELF MCULIB V5 GCC12.2 : for N22 architecture chips, from RDS V5.3.x

e TL32 ELF MCULIB V5F GCC10.3 : for D25F architecture chips, from RDS V5.1.2
+ Telink TLSR9 D25F GCC 10 : same as TL32 ELF MCULIB V5F GCC10.3

« TL32 ELF MCULIB V5F GCC7.4 : for D25F architecture chips, from RDS V3.2.3
» Telink TLSR9 D25F GCC 7 : same as TL32 ELF MCULIB V5F GCC7.4

5.2.1 Advanced usage: toolchain setting according to path

Normally, users shouldn’t set the toolchain by changing toolchain path. Instead, a toolchain should be set
with the method mentioned in the previous section: Select a different toolchain for TLSR9 projects

This section is for advanced users with special requirements.

Open the project property dialog by clicking the Property menu item on right and click the pop-up menu on
the project:

AN-22063002-E1 12 Ver1.0.10
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Switch to the C/C++ Build -> Settings -> Toolchains tab:

Resource
Builders
¥ C/C++ Build
Build Variables
Environment

& Taol Settings |®) Toolchsins (M Devices M Devices () Container Settings # Build Steps ' Build Artifact [} Binary Parsers @ Error Parsers

Configuration: | UART Demo [ Active ]

- 3 Name: ‘Te\ink TLSRY D25F GCC 10 (riscv32-elf-gec)
Tool Chain Editor
C/C++ General Architectures [Risc-v -]
et Prefic riscva2-clf-
Linux Tools Path
McU Suffi

Project Natures € compiler:
Project References

Run/Debug Settings
Task Tags Archiver: ar
TC32 Loader

TelinkFormatter

@ |[a
a
A

C++ compiler: -

Hex/Bin converter: [objcopy
Validation Listing generator: |objdump
WikiText Size command:

Build command:

Z|[¥
2
;

Remove command: | rm

Toolchain path: | ${eclipse_home)/RDS/V5.1.2/toolchains/nds32le-elf-meulib-vS/bin

(to change it use thd global pr workspace preferences pages or the project properties page)
Build tools path: [Sleclipse_home)/RDS/V5.1.2/cygwin/bin

(to change it use the global or workspace preferences pages or the project properties page)

Create flash image
Create extended listing
Print size

Figure 5.2: Toolchain setting

Click the global link text which is surrounded in red square block.

Set the path string in the line edit.

type filter text Global RISC-V Toolchains Paths - -

v MCU A
Global Arm Toolch:
Global Build Tools
Global OpenOCD P
Global pyOCD Path Toolchain name:  Telink TLSRS D25F GCC 10

Global QEMU Path
H Glahal RISEV Tanl

Configure the locations where various GNMU RISC-V toolchains are installed. The values are stored within Eclipse. Unless
redefined more specifically, they are used for all projects in all workspaces.

Default toolchain: | --- Global default --- v

Toolchain folder: |${ec|ipse_h0me},(RDSN5.1.2,(t00|chains,fnd532|e-e|f-mcu|ib-Y_S_fibin | Browse... xPack...

Figure 5.3: Set Toolchain path

Normally, users would only be required to change the version and the suffix which are marked with red
lines.

The first red line marks the toolchain base version string (in the image itis V5.1.2 ) of the toolchain, users
can change it to one of the following items:

 V3.2.3 : from Telink RDS IDE V3.2.3
e V5.1.2 : from Telink RDS IDE V5.1.2
* V5.3.x : from Telink RDS IDE V5.3.x

The second red line indicates the version of the toolchain variants string (in the image itis nds32le-elf-mculib-v5f
) of the toolchain, users can change it to one of the following items:

AN-22063002-E1 13 Ver1.0.10
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+ nds32le-elf-mculib-v5f : for Telink TLSR9 D25F chips

* nds32le-elf-mculib-v5 : for Telink TLSR9 N22 chips

Once the toolchain path variable has been changed, click the apply and close button to save it.

6 Import and build projects

6.1 TLSRS8

Telink 10T studio supports SDK or projects import function like the Telink old IDE.

Users can use the File -> Import...

to import SDK or projects:

T Import

Select

Select an import wizard:

Create new projects from an archive file or directory.

type filter text

v = General
JE Archive File
<
[ File System

] Preferences

= C/C++

= Git

(= Install

= Oomph

= RPM

= Run/Debug

-

=2 Existing Projects into Workspace

[, Projects from Folder or Archive

?\ = Back

Next =

Einish

Cancel

O ECpsE. emMDeEacar...  SUEL075ST

Users can refer to this Telink wiki page.

=T

Figure 6.1: Import
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6.2 TLSR9

For Telink RDS IDE format projects( for example, the SDKs for TLSR9 chips at Telink official wiki page),
it must be converted to Telink IoT studio format before importing it into the workspace.

Users can refer to the following RDS to IDE converter section on Telink menu chapter to view how to
do it.

7 Telink menu and toolbar entries

7.1 RDS to loT Studio converter

If you get the SDK or projects for TLSR9 chip B91 from Telink official wiki page, they arein Telink RDS IDE
format, you can use this function to convert it to Telink IoT studio format before importing it into Telink
loT studio, and SDK or projects of B92 do not require conversion.

Click the Telink RDS to IDE Converter in Telink menu:

nk loT Studio

ate Search Project Run T Telink Window Help

5 Di% e | Rl Telink RDS to IDE Converter REIQ -0~~~ 9~
yect Explorer [2.  Telink loT5tudio to Cmake

r_Demo (in B92) [telink b91m E Windows BDT (SWS and Jtag)
’ Jtag Burn (5PI Burn)

8 Telink loT Studie User Guide
@ Projects and Artifacts shortcuts ¥

Toolchain Shell or ICEMan shell »

=k
@ Telink Links »
Q

Search on DocSite

Figure 7.1: Telink Menu

Click the Select .cproject file button in the dialog to choose the Telink RDS IDE format .cproject
file.

In Linux OS, users can use Ctrl + h or other shortcut keys to show the hide files ( .cproject ), and the
filter should be changed to * :
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Converter setting

Converter util location: | fhome/hexiongjun/Projects/CDT_Telink_IDE/eclipse/tools/Converter/TelinkRDS2IDE | | Select TelinkRDS2IDE exe/ELF

RDS .cproject

.cproject File location: | Click the select button on right to select .cproject file —>=> Select .cproject file

Verbose Log | Convert

Log and info
2022-07-11 11:17:12 CST
Platform Info: Linux amd64

Usage Steps:
1. Select the RDS format '.cproject’ by clicking the "Select a file’ button
2. Click the "convert’ button to do the convert to IDE format
3. Click the "OK' button to import the project

Recent 4| SDKs | telink b91m_driver sdk-2 | project | tlsr_riscv | B91 | »

Home
Name Size Modified v

Desktop \+| .project 7.6kB 27 Jan
Documents k4 .cproject 627.4kB 27 Jan

Downloads
Music

Pickures

Videos

Figure 7.2: Linux Select cproject

If 8 .cproject file has been selected, it will display the file path:
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¥ Telink Project converter: RDS to IDE >
Converter setting
Converter util location: |C:\IDEReIease\EDEEDﬁED_V1 .D\eclip5e\too|s\Conver‘ter\TeIinI-cRDSElDE.exe| Select TelinkRDS2IDE exe/ELF
RDS .cproject
«cproject file location: |C:\U5ers\admin\DesI-ctop\teIinI-c_b91m_driver_src\project\tlsr_riscu\BQE\.cproject | |§Select .cproject ﬂ|e§|
[1Verbose Log |Convert
Log and info
2022-06-21 11:27:26 CST
Platform Info: Windows 10 amd64
Usage Steps:
1. Select the RDS format ".cpraoject’ by clicking the 'Select a file' button
2. Click the 'convert' button to do the conwvert to IDE format
3. Click the "OK' button to import the project
B
E L
p
s
)
® oK Cancel
L L ________ anaa s me L1191
Figure 7.3: Telink project converter
Then click the convert button, the result would show on the large text block:
17 Ver1.0.10
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¥ Telink Project converter: RDS to IDE

Converter setting

Converter util location: |C:\IDEReIease\2D22Dﬁ2D_V1.D\eclipse\tooIs\Conver‘ter\TelinI-cRDS2IDE.exe| Select TelinkRDS2IDE exe/ELF

RDS .cproject

«cproject file location: |C:\Projects\CDT_IDE_dev\telinl-c_b91 m_driver_src\project\tlsr_riscv\BQ2\Bac|-cup_before_| Select .cproject file

[1Verbose Log

Log and info
2022-06-21 17:47:11 CST
Platform Info: Windows 10 amd64

[2022/06/21T17:47:43] [NOTICE] CProject file is Telink RDS IDE format, continue ...
[2022,/06/21T17:47:43] [INCOTICE] ----- Configuration list from original project file, count:31

0:UART_Demao 1:Debug_Demo 2. TIMER_Demo
3:PWM_Demo 4:5P1_Demo S:Flash_Demo
6:s7816_Demo TALG_REG_Demo B:GPIO_Demo
9%:12C_Demo 10:RF_Demao 11:TRNG_Demao
12:USB_Demo 13:5TIMER_Demo 14:AUDIO_Demo
15:VCD _Demo 16:DHRYSTONE 17:COREMARK
18:AES_Demo 19:PM_Demo 20:LPC_Demo
21:HTOL_Demo 22:Test_Demo 23:EMI_BQB_Demo
9 24:Auto Test Demo 25:Make lib 26:PLIC_Demo
n 27T:ADC Demo 28:5wire_Demo 29:PKE_Demo L
30:QDEC_Demo
[2022/06/21T17:47:43] [NOTICE] ---------------------- buildPath count:31 ---------- oo
[2022/06/21T17:47:43] [NOTICE] ~--=nnnnmmmmcmmamaaaan Excluding count:31 ------mmmmmmmmmmenee

[2022/06/21T17:47:43] [NOTICE] Write target project file successfully
[2022/06/21T17:47:43] [NOTICE] Origin file: C:\Projects\CDT_IDE_devitelink b31m_driver src\projectitlsr riso\B92\Backup before ¢

[2022/06/21T17:47:43] [NOTICE] Origin file path: C\Projects\CDT_IDE_dew\telink_b31m_driver_src\project\tlsr_riscvyB92\Backup bef
[2022/06/21T17:47:43] [NOTICE] Successful backup origin file to: C\Projects\CDT_IDE_devitelink_b91m_driver_src\projectitlsr_risov,

[2022/06/21T17:47:43] INOTICE] Successful generated target file : C\Projects\CDT IDE dewtelink b%1m driver src\project\tlsr riscy v
b

<

@' OK Cancel

Figure 7.4: Converter result

If it is fails, the background of log text block would be set to red. Users can copy and send the log to

Telink IoT studio developer/FAE to get support.

7.1.1 Using converter as a standalone utility

The converter can be used as a standalone utility, users can use it in command line.

The converter is installed at:

« Windows: SloTStudio_PATH/tools/Converter/TelinkRDS2IDE.exe
» Linux: SloTStudio_PATH/tools/Converter/TelinkRDS2IDE

To convert 3 .cproject file from command line in Windows OS, users can use following the command:
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$IoTStudio_PATH/tools/Converter/TelinkRDS2IDE.exe Path/To/.cproject
In Linux OS:

$IoTStudio_PATH/tools/Converter/TelinkRDS2IDE Path/To/.cproject

7.1.2 Notice

The converted project ( .cproject ) would set the toolchain to Telink TLSR9 D25F GCC by default, which
will use the Telink RDS IDE 7.4 GCC Cross compiler for D25F.

7.2 Telink l1oTStudio to Cmake converter

If you need to convert the Telink loTStudio project to a cmake project, you can use the tool shown in the
following figure.

First, you need to double-click to select the project you want to convert, and then click Telink IoTStudio to Cmake
in Telink menu.

wis_pack - lelink lo] Studio
Edit Mavigate Search Project Run ¥/ Telink Window Help

i | FELEE TR | Telink RDS to IDE Converter BIQ H+*~0 "G ~qg~ - -

Debug i Project Explorer [.  Telink loTStudio to Cmake
I,-% = B92 Driver_Demo (in B92) [telink_b%1m E Windows BDT (SWS and Jtag)
#F, Binaries ? Jtag Burn (SPI Burn)

i Includes . . . .
Telink 10T Studio User Guide

W

[y boot

g = common &) Projects and Artifacts shortcuts »
& fi .

by con Ilg Sji  Toolchain Shell or ICEMan shell >
gy = drivers

g link @ Telink Links »
(= UART Demo Q Search on DocSite

[ vendor

Figure 7.5: Telink loTStuio to Cmake

You can choose whether to generate the settings.json file required for the VS Code project. Click Convert
to obtain the CMakelists.txt and settings.json files, and the log will indicate their location.
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Cproject [eUserswt 150, b9Tm_driver_src\projectitsr_risc\89: o =
A Generate wscode/settingsjson
tingsjson Path: | CUsers\wi_15\Download Packasi T2t 1=

Other options: |

Log

app_config: ./module_app_path.xml

False
\Users\wf 15\ Downloads\TelinkloTStudio, dtCmak

tool None
platform: None:

CUs \D:  b91m_driver_sre\proj - risc\B9: ot
sdk_top_dir CA\Users\wi_15\Deskiop\wks\telink b81m_driver_src

generate DEFAULT cmake

default cmake process..

generate C\Users\wi_15\Desktop\wks\telink 691m driver src/CMakeLists.

generate C\Users\wi_15\Deskiop\wha\telink_b81m driver sre

module_cmakes

module_cmakes finish
generate vscode cmake setting to CAUsers\wf_15\Downloads\TelinkloTStudio_Pack dt2Cmak
Download: | dt2Cmake

in Is\Cdt2Cmake vscs

= re\wT_ 15\Download\TelnkloTStadio. G2Cmak:
s been updated at CAUsers\wf_15\Downloads\TelinkloTStudio_ dt2Cmak
ish
basheg.
expart § SV TelinkloTStudiofbin

ed CAUsers\wi_15\Desktopiwks\telink_b91m_dri
Id -DTOOLCHAIN PATH="C:
- build —target UART Demo

inkloTStudio\RDS\VS.1.2\toolchains\nds32le-elf-meulib-vsf"

Figure 7.6: Telink loStudio to Cmake Ul

7.3 Jtag burn menu

The 3Jtag_Burn function is similar to the Telink RDS IDE Jtag_Burn function, both use the JTAG to burn
the image to TLSR9X chips.

Except for the Jtag_Burn , TLSR9 can be burned with Windows BDT software through SWS protocol with
Burning EVK , which is the recommended option.

The SWS protocol requires only one GPIO to flash the binary image to TLSR8 and TLSR9 chips, while the
JTAG uses 2 or 4 GPIO pins for TLSR9 chips.

7.3.1 Parameters

Once the Jtag_Burn dialog has been opened, users can fill or set parameters for Jtag_Burn and ICEMan:
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Flashing Drivers and ICEMan

Jtag_Burn utility Path [CATelinkioTStudio\RDS\V3.2.3\flash\itag_burn.exe Select Jtag_burn [ vl

ICEMan exe/ELF [AlinkloTStudio\RDS\V5.1.2\ice\ICEman.exe Select ICEMan MCU Architecture: ‘vs v‘

Flashing Image/Binary and Other ICEMan arguments
[ir_srevprojectitlsr_riscv\B92\GPIO_Demo\GPIO_Demo.bin | |selectimage Programming Start Address: [oxo

Other ICEMan Arguments:
Target management ICEMan/SPI_burn Host: [127.0.0.1 Bunner Port: [2354

Target Bum

[J Enable target burn Target burn image: Select image

Jtag_burn Driver Arguments ICEMan Interface cfg

Target Chip: 892 | Flash Controller Address: | | Misc Arguments:
[ verification [JErase All unlock [ Lock after burn Reset and Run [] Encrypt
[JICEMan Interface Config: | ~] Telnet Port: [4444 ]

Logging: <== Jtag Burn || ICEMan ==>

>> Flash page program at address 0x000400 ~|[-— start the ICEMan at: 2023-08-28 10:44:45-——-

>> Flash page program at address 0x000800 Args:[CATelinkloTStudio\RDS\VS. 1.2\ice\ICEman.exe, -Z, v5, -b, 2354]
>> Flash page program at address 0x000c00 Andes ICEman (OpenOCD) 5.1.1-g3a324fc9 (2022-04-22-14:27)
>> Flash page program at address 0x001000 Burner listens on 2354

>> Flash page program at address 0x001400 Telnet port: 4444

>> Flash page program at address 0x001800 TCL port: 6666

>> Flash verify ok at address 0x000000 Andes AICE-MINI+

>> Flash verify ok at address 0x000400 JTAG frequency 10.000 MHz

>> Flash verify ok at address 0x000800 There is 1 core in tap

>> Flash verify ok at address 0x000c00 The core #0 listens on 1111,

>> Flash verify ok at address 0x001000 ICEman is ready to use.

>> Flash verify ok at address 0x001400 hardware reset-and-hold success on [nds.tap] hart 0
>> Flash verify ok at address 0x001800

>> File download to flash success at address 0x00000000: 6916 bytes
>> MCU reset and run

SPI_Burn exited with code:0

< >

StartICEMan before burning Stop ICEMan | Burn

Figure 7.7: Jtag burn dialog

Parameters for Jtag_Burn can be setin Jtag Burn driver Arguments

7.3.2 Use ICEMan in Jtag_Burn dialog

ICEMan is a tool to manage the TLSR9 JTAG ICE (support 4-wire and 2-wire mode).

Users can refer to the document files in the doc directory to get more information.

7.3.3 ICEMan in Jtag_Burn ELF setting
Users can set the other ICEMan and Jtag_Burn ELF from Flashing Drivers and ICEMan section, the set/
selected value will be saved and reused in next re-opening the dialog.

The normal ELF files’ names are listed for reference:

« ICEMan: ICEMan.exe in Windows, and ICEMan on Linux OS
e Jtag_Burn: Jtag_Burn.exe in Windows, and Jtag_Burn on Linux OS

7.3.4 Burn Program

When burning the program, pay attention to burner’s path and chip type, and then click Start ICEman. After
ICEman is ready, the telnet_port and burner_port should be consistent with ICEman’s, then click Burn, as
shown below:
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Jtag_Burn utility Path | CATelinkioTStudio\RDS\V3.2.3\flash\itag_burn.exe Select Jtag_burn | | [ vl
ICEMan exe/ELF [inkioTStudio\RDS\V5.1.2\ice\ICEman.exe | Select ICEMan MCU Architecture: [v5 v
Flashing Image/Binary and Other ICEMan
[ir_srevprojectitlsr_riscv\B92\GPIO_Demo\GPIO_Demo.bin | |select image Programming Start Address: [oxo
Other ICEMan Arguments:
Target management ICEMan/SPI_burn Host: [127.0.0.1 Bunner Port: [2354 | 4
Target Burn
[J Enable target burn Target burn image: Select image

Jtag_burn Driver Arguments ICEMan Interface cfg 3

Target Chip: [892 [ Fash Controller Address: | Misc Arguments: |
Verification [TErase All Junlock [ Lock after burn Reset and Run [ Encrypt
[JICEMan Interface Config: | ~] | Telnet Port: 4444 ] | 5

Logging: <==Jtag Burn || ICEMan ==>

>> Flash page program at address 0x000400 A || ---- Start the ICEMan at: 2023-08-28 10:44:45----
>> Flash page program at address 0x000800 Args:[C:\TelinkloTStudio\RDS\V5. 1.2\ice\ICEman.exe, -Z, v5, -b, 2354]
>> Flash page program at address 0x000c00 Andes ICEman (OpenQOCD) 5.1.1-g3a34fc9 (2022-04-22-14:27)
>> Flash page program at address 0x001000 Burner listens on 2354
>> Flash page program at address 0x001400 Telnet port: 4444
>> Flash page program at address 0001800 TCCport: 6666
>> Flash Verify ok at address 0x000000 Andes AICE-MINI+
>> Flash Verify ok at address 0x000400 JTAG frequen(y 10.000 MHz
>> Flash verify ok at address 0x000800 There is 1 core in tap
>> Flash verify ok at address 0x000c00 The core #0 listenson 1111,
>> Flash verify ok at address 0x001000 ICEman is ready to use.
>> Flash verify ok at address 0x001400 hardware reset-and-hold success on [nds.tap] hart 0
>> Flash verify ok at address 0x001800
>> File download to flash success at address 0x00000000: 6916 bytes |l Stopped the ICEMan at: 2023-08-28 10:48:04----
>> MCU reset and run
SPI_Bumn exited with code:0
s

- .

1 6

Start ICEMan before burnirjg Start ICEMan El

Figure 7.8: Jtag burn

Jtag_ Burn is located in the SloTStudio_PATH/RDS/V3.2.3/flash/directory, and its help documents are also
in the same directory.

7.3.5 Security Download

If you need to use the security download function of Jtag_Burn, check the encrypt checkbox
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Flashing Drivers and ICEMan

Jtag_Burn utility Path [CATelinkioTStudio\RDS\V3.2.3\flash\itag_burn.exe Select Jtag_burn

ICEMan exe/ELF

Flashing Image/Binary and Other ICEMan arguments

+linkloTStudio\RDS\V5.1.2\ice\ICEman.exe Select ICEMan MCU Architecture: ‘vs

[ir_srevprojectitlsr_riscv\B92\GPIO_Demo\GPIO_Demo.bin | |select image Programming Start Address: [oxo
Other ICEMan Arguments:

[] Target management ICEMan/SPI_burn Host: [127.0.0.1 Bunner Port: [2354
Target Burn

[J Enable target burn Target burn image:

Selectimage

Jtag_burn Driver Arguments_ICEMan Interface cfg

Target Chip: [892 | Flash Controller Address: | | Misc Arguments:

[ verification [JErase All unlock [ Lock after burn Reset and Run | [Z] Encrypt

[JICEMan Interface Config: | v Telnet Port; 4444 |

Logging: <==Jtag Burn || ICEMan ==>

>> Flash page program at address 0x000400 ~|[-— start the ICEMan at: 2023-08-28 10:44:45-——-
>> Flash page program at address 0x000800 Args:[CATelinkloTStudio\RDS\VS. 1.2\ice\ICEman.exe, -Z, v5, -b, 2354]
>> Flash page program at address 0x000c00 Andes ICEman (OpenOCD) 5.1.1-g3a324fc9 (2022-04-22-14:27)
>> Flash page program at address 0x001000 Burner listens on 2354
>> Flash page program at address 0x001400 Telnet port: 4444
>> Flash page program at address 0x001800 TCL port: 6666
>> Flash verify ok at address 0x000000 Andes AICE-MINI+
>> Flash verify ok at address 0x000400 JTAG frequency 10.000 MHz
>> Flash verify ok at address 0x000800 There is 1 core in tap
>> Flash verify ok at address 0x000c00 The core #0 listens on 1111,
>> Flash verify ok at address 0x001000 ICEman is ready to use.
>> Flash verify ok at address 0x001400 hardware reset-and-hold success on [nds.tap] hart 0
>> Flash verify ok at address 0x001800
>> File download to flash success at address 0x00000000: 6916 bytes Stopped the ICEMan at: 2023-08-28 10:48:04-——
>> MCU reset and run
SPI_Burn exited with code:0
v
< >

Start ICEMan before burning Start ICEMan | Burn

Figure 7.9: Jtag Burn Encrypt

7.4 Telink links

In this sub-menu, users can quickly visit Telink websites for development resources or information:

» Telink forum
* Telink wiki
+ Telink official webpage
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ject Run 7 Telink Window Help
R Telink RDS to IDE Converter 2IQ H-0-Q- 9~ - 5l

s, Telink loTStudio to Cmake
elink_b91w [§ Windows BDT (SWS and Jtag)
’ Jtag Burn (SPI Burn)

Telink loT Studic User Guide

L
o

@y Projects and Artifacts shortcuts »
St Teoolchain Shell or ICEMan shell >
(1) Telink Links * &) Go to Telink Forum
@, Search on DocSite T Go to Telink Home Page
A Go to Telink wiki page
Figure 7.10: Telink Links
¥ Open launcher Failed *

'@' Mot found the launcher file: TelinkTools/Telink.exe

OK

Figure 7.11: Telink tools launcher

7.5 libusb version BDT

The 1libusb version BDT is a new burning tool which is similar to Windows BDT for Windows OS and
Linux OS, but this tool requires Burning EVK with new firmware. This tool can be used to flash the image to
TLSR8 and TLSR9 chips through SWS. This tool is still in the beta phase. If this tool is not working on some
Windows OS, use the Windows BDT (mentioned in the following Windows BDT section) instead.

Users can launch this tool and click the help on libUSB BDT menu to learn how to use it.

Clicking this menu entry would open the libusb version of BDT and pass the artifact bin path to it if a
project has been selected and the artifact has been found, so users do not require to copy the artifact path
manually:
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T Telink Debug Too — O >
o=
8, QL
= @ _\
i N d ik Telink utils
T - - -
eclipse-workspace-dev - Telink IDE Ci\Projects\COT_IDE_dev\BTBLE_SDK\b91 btble controller sdid,
Welcome to Tell File Edit Source Refactor MNavigate Search Project Rufl pri_btble_controller\_prj_btble_cantroller_bin
= EXC S H-E AT Y 11 A R = R A
= 5 - g I~ Bl - | Q ®| B
75 Project Explorer = B8 = 3 » =08
BES YT
= b85m_ble_single_connection_sdk (in b There is no
Lot B9l Deiyer Demo (o B0 ool b active editor
Ir> eagle btble_sdk (in b91_bthle_control that provides
an outline.

Figure 7.12: Open libUSB BDT with artifact Path

If no project is selected, a error dialog would show, users can close it, the libusb BDT program would be
started normally as well:

T Unexpected Selection Class >

| . Expected a TreeSelection but got a StructuredSelection instead. =
L 4 Processing Terminated.

Figure 7.13: Open libUSB BDT without artifact Path

7.6 Toolchain shell or ICEMan shell menu entry

This is 8 submenu, it has several menu entries to start the toolchain console or ICEMan console, users can
input commands (for example: riscv-elf-gcc or ICEMan ) in these shells.

It is worth noting that we provide two versions of ICEman. Under ${IoTStudio_Path}/tools/ice_cygwin_from_andes/

, there is the original version of ICEman, while under ${IoTStudio_Path}/tools/ice/ , there is a new
version of ICEman used by loTStudio by default. It has made some modifications to match the functionality
of loTStudio and currently does not support IPv6.
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rendor/commen/subdir.mk - Telink loT Studic
Run T Telink | Window Help

... Telink RDS to IDE Converter O ~R-~ Q™ 5 - - v 1 f - |
G, T kL Telink IoTStudio to Cmake L4

B Windows BDT (SWS and Jtag)
ti_con| # Jtag Burn (SPI Burn)

&
o

Telink loT Studic User Guide Fonsole | & Properties B Progress

& Projects and Artifacts shortcuts »

=t Toolchain Shell or ICEMan shell *» B Launch RISCV V5F(D25F) toolchain Shell (RDS 3.2.3 GCC 7.4) for TLSR9

@ Telink Links > B Launch RISCV V5(N22) toolchain Shell(RDS V3.2.3 GCC 7.4) for TLSRS

Q Search on DocSite B Launch RISCV V5F(D25F) toolchain Shell(RDS ¥5.1.2 GCC 10.3) for TLSR9
B Launch RISCV V3(N22) toolchain Shell(RDS v3.1.2 GCC 10.3) for TLSRS
B Launch RISCV VSF{D25F) toolchain Shell (RDS 5.3.x GCC 12.2) for TLSR9
B Launch RISCV V5(N22) toolchain Shell (RDS 5.3.x GCC 12.2) for TLSR9
B Launch ICEman Shell (V5.3.x) for TLSR9

Figure 7.14: Shells

7.7 Windows BDT

The Windows BDT (SWS and JTAG) menu item would open the standalone program Windows BDT . Users
can use this tool to flash or debug the TLSR8 and TLSR9 chips.

Refer to this wiki page on how to use it.

7.8 Open artifact path

There’s an icon on the toolbar used to open the artifact directory:

R-B@R% s % Bi|g-
ES Y — 8
_connection_sdk (in b85_ble_sdk)

mao (in B21) [telink_ b91m_driver_src master]

Figure 7.15: Open artifact path

It wouldn’t work if the project was not properly configured (the .cproject file), this occurs in many old
TLSR8 SDKs.

While most TLSR9 SDK projects work as expected.
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7.8.1 Notice

The project or project file must be selected before clicking the icon, otherwise it will not work.

7.9 Copy artifact path

The Telink IoT studio added a handy menu entry to help users copy the artifact path:

oject Run T Telink Window Help
| Rl Telink RDS to IDE Converter BEHA B~ 0" @~ 9~ - -

[z, Telink loTStudio to Cmake
[telink b91r E Windows BDT (SWS and Jtag)
’ Jtag Burn (5Pl Burn)

2 Telink loT Studic User Guide

@- Projects and Artifacts shortcuts ¥ % Copy artifact(.bin) file path

Toolchain Shell or ICEMan shell »

=k
@ Telink Links »
qQ

Search on DocSite

Figure 7.16: Copy artifact path

Users can click this icon to copy the artifact path to the system clipboard.

7.9.1 Notice

The project or project file must be selected before clicking the icon, otherwise it will not work.

7.9.2 In other places

The Copy artifact path menu entry also shows at toolbar and right-click the pop-up menu:

¥ 111 - Telink loT Studio

File Edit Source Refactor Navigate Search Project Run [*/ Telink Window Help

il g | B>/~ @ D% w %LQ@'@E'E"G"*'O'QEVQ‘QJ' A b 5 |
&5 Project Explorer % = p‘( %

Figure 7.17: Copy artifact path on Toolbar
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v Telink > @l Copy Artifact Path I} |

Properties Alt+Enter

Figure 7.18: Copy artifact path on pop-up menu

7.10 Search on DocSite

This tool can be used to search for specific keywords in the Telink Document Center website. Double click a
keyword in the project file and click “Search on DocSite” to jump to the Document Center search page.

*! wks - B92_Driver_Demo/drivers/gpio.h - Telink loT Studio = 8 X
File Edit Source Refactor Navigate Search Project Run (¥ Telink Window Help
[nil | ®~®~ @ D% 2L % WEHQ @~ ¢ @ TelinkRDS to IDE Converter Fridp@Tif-Hed ey m Qg EE
& g =08 =8 & @® =a
[& Project Explorer X B Y “ B Windows BDT (SWS and Jtag) % Out.. X @Buil.. &3Doc... B Doc...
g i (in B97) 4, A W 8
» &5 B91 Driver Demo (in 69 4 Jtag Burn (SPI Burn) BN o %
v &5 B92_Driver_Demo (in B92) & libusbBDT 4 analog.h
> & Includes j 1ous o reg_include/gpio_reg.h
> G boot 4 @ Settings and Log > @ (anonymous)
> & common 4 @ gpio_group_e:enum
> @ drivers 4 © TelinkIDE User Guide 5> @ (anonymous)
» & GPIO_Demo 4@ Pprojects and Artifacts shortcuts > o . T gpio_pin_e: enum
> G link 4 level(gpic_pin_e pin) > @ (anonymous)
> & UART_Demo 4 5 Toolchain Shellor ICEManshell > ) @ gpio_func_pin_e : enum
> @& vendor j T _in(pin), pin & Oxff); > @ (anonymous)
> 1% B93_Driver_Demo (in 893) S step 2 ® gpio_func_e: enum
Q  search on DocSite 5 @ (anonymous)
e This fu Search selected symbol on Telink docsite f1eye1 . @ gpio_fuc e :enum
p - the buffer used to store all the pins' input level > @ (anonymous)
none ® gpio_irq_status_e: enum
o X X X . > @ (anonymous)
4425 static inline void gpio_get_level all (unsigned char *p) ® gpio_irq_mask_e : cnum
req gpio pa_in; >0 (anonymous)
req_gpio pb_in ® gpio_group_irq_e: enum
reg_gpio_pc_in; I > @ (anonymous)
reg_gpio_pd_in; ® gpio_pol e:enum
reg_gpio_pe_in; > @ (anonymous)
} T gpio_irq_trigger_type_e : enum
. > @ (anonymous)
® gpio_pull type e:enum

This function set the pin toggle.
pin - the pin needs to toggle. % gpio_function_en(gpio_pin_e): void
none. % gpio_function_dis(gpio_pin_e): void
° gpio_set_high level(gpio_pin_e): void
° gpio_set_low_level(gpio_pin_e) : void
©° gpio_set_level(gpio_pin_e, unsigned ch
©° gpio_get_level(gpio_pin_e) : bool

static inline veid gpio_toggle (gpio_pin_e pin)
{
pin) A= (pin & OXEF);

! tep 1 ©° gpio_get level all{unsigned char) : voi
4610 /% step ©° gpio_toggle(gpio_pin_e) : void
i1 Problems & Tasks & Console x [ Properties x| ¢ ¢ EE-ESIrE-Or=0

CDT Build Console [B92_Driver_Demo]
riscv32-elf-gcc -memodel=medium -memodel=medium -00 —fmessage-length=0 —ffunction-sections -fdata-sections -flto -g3 —T "C:\Users\DELL
\Desktop\wks\telink b9lm driver src\chip\B92\link\flash boot.link" startfiles -Xlinker --gc-sectio L"C:\Users\DELL\Desktop\wks

Figure 7.19: keyword
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T httpsy/doc.telink-semi.cn/ind: X+ (
C 0 @& doctelink-semi.cn/index/index/search.html?search=reg_gpio_out8&type=8&handbook=&product= 2 % @ o & 0O @ H
Chrome MR I= R BE =R
Telink E5¢is ks FEERASEIEAN EN v/ MK

reg_gpio_out

BR
R
AT
[, 18] 0 A TR
FHFM
uFiE

Figure 7.20: doc site

8 Common compiling error

8.1 Can’t find the link script file

This type of error would occur when link script file path is in relative format. This wouldn’t be an issue in
Telink RDS IDE , but there will be an error in Telink IoT studio

The error log would hint like the following:

"
Building target: AES_Demo.elf

Invoking: GNU RISC-V Cross € Linker

riscv32-elf-gce -memodel=medium -mcmodel=medium -02 -fmessage-length=8 -ffunction-sections -fdata-sections -flto -g3 -T ../link/flash_boot.link -nostartfiles -xlinker --gc-sections -L"C:\Projects
\CDT_IDE dev\telink bolm_driver src\chip\Balidrivers\lib" -Wl,-Map,"AES Demo.map” -02 -fpack-struct -fshort-enums -g3 -mcpu=d25f -ffunction-sections -fdata-sections -mext-dsp -mabi=ilp32f -
fmessage-length=6 -fomit-frame-pointer -fno-strict-aliasing -fshort-wchar -fuse-ld=bfd -Wno-gnu-zero-variadic-macro-arguments -o "AES_Demo.elf” . /vendor/common/flash/puya_commen.o

. /vendor/common/flash/puya_flash_scratch.o ./vendor/common/flash/puya_flash_trim.o ./vendor/common/calibration/calibration.o ./vendar/common/plic_isr.a ./vendor/common/printf.o

. /vendor/AES_Demo/app.o ./vendor/AES_Demo/main.c ./drivers/lib/src/pke/eccp_curve.o ./drivers/lib/src/pkefecdh.c ./drivers/lib/src/pke/ecdsa.o ./drivers/lib/src/pke/pke.o
.fdrivers/1lib/src/pke/pke_common.o ./drivers/lib/src/pke/x25519.0 ./drivers/lib/src/emi.c ./drivers/1lib/src/plic.o ./drivers/lib/src/pm.o ./drivers/lib/src/rf.o ./drivers/lib/src/swire.o
./drivers/lib/src/sys.o ./drivers/lib/src/trng.o  ./drivers/flash/flash_mid146885.c ./drivers/flash/flash_mid156@85.0 ./drivers/flash/flash_mid166885.c ./drivers/adc.c ./drivers/aes.o
.fdrivers/analog.o ./drivers/audio.o ./drivers/clock.o ./drivers/flash.o ./drivers/gpic.o ./drivers/i2c.o ./drivers/lpc.o ./drivers/mdec.o ./drivers/npe.o ./drivers/pwm.c ./drivers/s7816.0
./drivers/spi.o ./drivers/stimer.o ./drivers/timer.o ./drivers/uart.c ./drivers/usbhw.c ./common/usb_dbg/myudb_usb.o ./commen/ush_dbg/myudb_usbdesc.c ./common/bt_debug/dbgport.o
./boot/cstartup_flash.o ./boot/cstartup_ram.o  -ldriver -laxon_driver_lib

fcygdrive/c/IDERelease/20220620 V1.8/eclipse/RD5/V3.2.3/toolchains/nds321e-elf-mculib-v5f/bin/. . /1ib/gcc/riscv32-elf/7.4.8/../../../. . /riscv32-elf/bin/1ld.bfd: cannot open linker script file
../link/flash_boot.link: Ne such file or directory

collect2: error: 1d returned 1 exit status

make: *** [makefile:71: AES_Demo.elf] Error 1

"make -j4 all” terminated with exit code 2. Build might be incomplete.

10:54:59 Build Failed. 1 errors, ® warnings. (took 31s.427ms)

| v

Figure 8.1: Link error

To resolve this problem, users can open the project property, then navigate to linker’s General page of
Tool Settings tab as following image, then double click the link script file:
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type filter text

» Resource
Builders
w CfC++ Build
Build Variables
Environment
Logging
Settings
Tool Chain Editor
» CfC++ General
Git
Linux Tools Path
Project Matures
Project References
RISC-V Toolchains Paths
Run/Debug Settings
Task Tags
TC32 Loader
Validation
WikiText

W

T| Properties for B91_Driver_Demo

Settings

CI=

Configuration: |AES_Demo [ Active ]

& Toaol Settings ¥ Toolchains M Devices M Devices [0 Container Settings - Build Steps Bf+|*

(2 Target Processor

~ | | Manage Configurations...

Script files (-T) & w3 Iﬁl |G|

(% Optimization
(% Warnings

s bootin —— |

% Debugging
w 8 GNU RISC-V Cross Assembler
(# Preprocessor

\

2 Includes ¥ Edit file path
(% Warnings
# Miscellaneous| File:

v & GNURISC-V Crol || flinkflash_bootlink

# Preprocessor
#2 Includes
(% Optimization
# Warnings

w % GNU RISC-V Cro|

(# Miscellaneous| Cancel File system...

\
\

(#2 General

2 Libraries

# Miscellaneous
w B3 GNU RISC-V Cross Create Flash Image

L '

Figure 8.2: Link file path

On opened dialog, select it from workspace
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T File selection

Select one or more Workspace Files

a

et

=% b85m ble single connection sdk
~ [== B91 Driver Demo

[= .settings
[= 3rd-party
[= AES Demo
= boot

[= common

= drivers

v = link

flash_boot ramcode.link
= flash_boot.link
ram_bootlink

[= UART Demo

= wendor

['||| ['|||

Ccproject

H]

Jgitignore

"
@

oK

Cancel

el e TS CVSISELT OIS IO. OOy

CdnMmoT OpET IINKET 56

Figure 8.3: Link file select

Click 0K and apply and close button, and rebuild the project to check the results.

9 Other plugins or functions

9.1 Telink Formatter

This plugin is used to format the code/file with format shortcut or saving a file with clang-format.

9.1.1 Use as formatter

To use it in formatter, users should set the Telink Formatter

from the menu
TelinkFormatter

Windows
in Cod

-> Preference -> C/C++ ->

as the default formatter. Open the setting

Code style

->

Formatter

e Formatter: list, then click the Apply and Close button:

, select the
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type Filter text

P General
v C/C++
Appearance
P Autotools
» Build
CMake
Code Analysis
¥ Code Skyle
Code Templates
Formatter
Name Style
P Organize Includes
Core Build Toolchair
P Debug
P Docker Container
b Editor
File Types
Indexer
JSON CompilationC

@ ®

Formatter Qwpw §

(=]

Configure Project Specific Settings...

Active profile:
GNU [built-in] v Edit... Remove
New... Import...
Code Formatter:
TelinkFormatter v

Note: Contributed Formatters may not respect all code style settings.

Preview:

,-'r’

* A sample source file for the code formatter preview

*/

#include <math.h>

class Point {public:Point(double x, double y) : x(x), yly) -
double x;double y;};

double Point::distance(const Point& other) const {double dx

Restore Defaults Apply

Cancel Apply and Close

Figure 9.1: Formatter setting

Then select Telink style in the settings of TelinkFormatter . Open the setting from the menu Windows

-> Preference -> C/C++

-> TelinkFormatter , selectthe Telink in Clang-ormat fallback style:

list, then click the Apply and Close button:
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type filter text TelinkFormatter P
» General The fallback style option would be used,
if no style File is found on the path of project tree
Appearance
» Autotools
} Build Clang-format fallback style] | Telink -
CMake Run clang-format on file save
Code Analysis @ show clang-format log in console
» Code Style
Core Build Toolchains
» Debug
» Docker Container
» Editor
File Types

Indexer
JSON Compilation Database Pai
Language Mappings
» MCU Packages
Meson
» New C/C++ Project Wizard
» Packages
» Profiling
» Property Pages Settings

TelinkFormatter
emplate Derault Values

Changelog
» Docker

Figure 9.2: TelinkFormatter setting

Afterwards users can press the shortcut keys (by default, it's Ctrl+Shift+F ) on any openned source code
file editor, a dialog would show, uses click the corronsponding button and option to confirm:

Mo code is selected. Choose the scope of Formatting.
© The entire file

The statement on the current line

Remember this choice and do not ask again

Cancel oK

Figure 9.3: Formatter hint

Afterthe Telink Formatter hasformatted the code/file, users can view the logsonthe Telink Formatter

output console for details (notice that the log function should be enabled in the TelinkFormatter Prefer-
ence dialog, check the following guide):
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& Problems B console X

Telink Formatter

------------ 2024-04-18 17:48:31 Format with options ------------
-assume-filename=/home/hexiongjun/Projects/CI/telink b91m driver src/chip/B91/drivers/pwm.c
-style=file
-fallback-style=Google
-offset=0
-length=6357

===> File has been formatted in Formatter mode, you can save it now

Figure 9.4: Formatter console output after formmtting

9.1.2 Trigger with saving event(recommanded method)

The formatter can be triggered when a file or multiple files are saving, this requires the selection of
the function in TelinkFormat setting(through the menu Windows -> Preference -> C/C++ ->
TelinkFormatter ):

Telink x| TelinkFormatter Hwihw §
v CfC++ The fallback style option would be used,
TelinkFormatter if no sktyle file is Found on the path of project tree

Clang-format Fallback style: | none v

Run clang-format on file save
Show clang-format login console

Restore Defaults Apply

e A
? el ® Cancel Apply and Close
Figure 9.5: Telink Formatter Preference

Afterthe Telink Formatter hasformatted the code/file, users canview thelogsonthe Telink Formatter
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output console for details if the log has been enabled in setting:

&. Problems & console X

Telink Formatter

------------ 2024-04-18 17:49:09 Format with options ------------
-assume-filename=/home/hexiongjun/Projects/CI/telink b91m driver src/chip/B91/drivers/pwm.c
-style=file
-fallback-style=Google

===> Applied the changes after formatting, you can save it now

Figure 9.6: Formatter console output after saving

9.1.3 Known issue

9.1.3.1 Save button is disabled at the first time

The “Save” button is int disabled state when a file is modified at the first time. After save it using "CTRL+S" (
or File -> Save ,or with Save all menu-item/button ), modify this file again, it will become enabled
state.

9.2 Easy Shell

This plugin allows to open a shell window or file manager from the pop-up menu in the navigation tree or
editor view. Additionally, it is possible to run selected files in the shell, copy file or directory path or run
user defined external tools.

ing — e
(&g driver New 5
link
g fin Go Into
= UART
g vendc ‘@ EasyShell * B Open Command Prompt Here
# 3rd-p Open in New Window [ Show in Explorer
5> Backu Show In Alt+Shift+W > |- Copy Full Path to Clipboard [

Show in Local Terminal * [2 Copy Qualified Name to Clipl ¢/casyshell:r

i [ gu—— el o [

Figure 9.7: Easy Shell

9.3 ECalculator

A calculator with lots of functions, including:

+ Display of the calculation in base-n numbers
» Standard, scientific and trigonometric calculation
+ Enter arithmetic expressions naturally
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Users can open it from the menu: Window -> Show view -> other... ,theninput Ecalculator to
search and open it:

[#] Problems & Tasks B Console [ Properties ECalculator = B8

DEG RAD GRAD | HEX| DEC BIM | Store Last Result‘ C AC = ==
PSbe OR fell

[ 1 %% 1/n n2 sqrt

7 +
52 M fn In e log 10~ L 2
. 1 2 3
E Pl 1 OR AMD XOR =
0 +/ *
sin cOs tan asin acos atan A B C
sinh cosh tanh o E /

Figure 9.8: ECalculator

9.4 Terminal in Eclipse

The terminal can be used for inputting git commands and serial debugging.

Users can open it from the menu Window -> Show View -> Terminal :

T Launch Terminal O X

Choose terminal: | Git Bash o

Settings
Local Terminal
Encoding: \UTF-{scy Terminal

Serial Terminal
Telnet Terminal

)

OK Cancel

Figure 9.9: Terminal Selection
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T Launch Terminal O >

Choose terminal: | Serial Terminal w
Settings
Serial port: E| W
Baud rate: 115200 o
Data size: 8 ~
Parity: Mone “
Stop bits: |1 W
Encoding:  Default (1I50-8859-1) ~

@ OK Cancel

arfice | W Tarmmimal o 60 BF alrilatar B Errar | o

Figure 9.10: Terminal for Serial

If your serial debugging log output frequency is very fast, use other dedicated tools instead.

9.5 Binary Viewer

This plugin is used to open the binary files:

{5 Project Ex.. % = B *40UART Demobin X = 8
5% Y7 § [1] [mex -]
> 12 b85m_ble_single_conne 00 01 02 03 04 05 06 07 08 09 0A 0B 0C 0D OF OF Gimary [«]
v 1z = BY1 Driver Demo (in 0000[25 A0 00 00 00 00 00 00 00 00 00 00 00 00 00 00[% [<]
> il Includes 001000 00 00 00 00 00 00 00 D8 34 00 00 00 00 00 00 4 F DudiudMi
5 (= AES_Demo 0020(4B 4E 4C 54 00 00 3B 17 97 01 08 EO 93 81 81 7D [ENLT ; H b
> G boot 0030(B7 02 10 80 93 82 02 70 13 03 00 04 A3 80 62 50 » kP [27
> G common 004097 02 0A E0 93 82 02 FC 16 81 97 02 00 EO 93 82 Word _
> @ drivers 005062 FB 73 90 02 80 99 62 F3 A2 02 30 73 10 30 00[b s b 0s 0
) G link 0060(97 22 00 E0 92 82 02 TA 72 90 52 20 72 60 01 70| ” zs Ros™ } |9532
« (> UART Demo 0070(B7 02 00 B4 09 43 23 AD 62 00 F3 22 A0 7C 93 E2 b | T
; & boot 008012 00 93 E2 22 00 73 90 A2 7C OF 10 00 00 17 03 s b3 1242752
(sle]
009000 00 13 03 23 10 97 03 00 E0 93 83 A3 F6 17 0E| = ||
» [ common N
) 004000 E0 12 OF GE OB 62 FO C3 01 83 22 03 00 23 40| n e # Long
> @ drivers 00B0|53 00 11 03 91 03 €5 BF 17 03 00 00 13 03 03 23S by #
s = vendor 2 B ' - = [2711166975677038592
00C0|93 03 80 15 17 OF 00 E0 13 OF 4F OF 63 F9 C3 01 e
Lg makefile 00D0|33 22 03 00 23 A0 53 00 11 03 91 03 C5 BF 17 03| " = § f A7
L& objects.mk 00E0[00 00 13 02 A2 25 97 03 00 E0 92 83 43 11 17 3F % [2.7755576E-15
L& sources.mk 00F0|00 E0 13 OF 4E 81 63 F9 C3 01 83 22 03 00 23 a0 Ne ° = . =
- . —
“ho UART Demo.bin  0100(53 00 11 03 91 03 C5 BF 17 33 00 00 13 03 83 39(§ [ 3§ ~I[4] m
£ UART Dema.map | UTF-8 4 [ 13528 (0) | - | A ovr|
» (g vendor
3 [g 3rd-party |_:: Problems | Tasks B Console X [ Properties ECalculator '2 Error Log x | &4 4 <=«=={’>| '—E EE i

Figure 9.11: Binary Viewer
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Users can double-click a binary file to open and view it in loT Studio.

10 FAQ

10.1 Error 127 when compiling the code
This error would give the Error 127 at console window:

i1l Problems ¥ Tasks & Console [ Properties

CDT Build Console [B92_Driver_Demo]

rizscv3Z-elf-geec -memodel=-medium -memodel=medium -02 -fmessage-length=0 -ffunction-sections -fdata-sections -flto -g3 -DMC
‘telink bSIm driver src CIhchip\B92\drivers" -I"E:\5DKs\telink b%lm driver src CI‘demo‘vendor‘common\BS2\calibration" -I"E
\telink_bSlrr._driver_sIC_CI\derf.o\vendor\corm.on\corm.on" -mext-dsp -mabi=ilp32f -c -fmessage-length=0 -fomit-frame-pointer
Zero-variadic-macro-arguments -fpack-struct -fshort-enums -fno-jump-tables -MMD -MP -MF"drivers/lib/src/pke/ecdh.d" -MI"dr
"E:fSDsttelink_bSlm_driver_src_clfchiPKB92Idriversflibfsrcfpkefecdh.c"

Building file: E:/SDEs/telink b9lm driver src CI/chip/BS2/drivers/lib/src/pke/pke.c

make: *** [drivers/lib/src/pke/subdir.mk:55: drivers/lib/src/pkefecdsa.o] Error 127

make: *** Waiting for unfinished jobs....

make: *** [vendor/common/subdir.mk:30: vendor/common/printf.o] Error 127

Building file: E:/SDEs/telink b9lm driver src CI/chip/BS2/drivers/lib/src/pke/pke prime.c

make: *** [vendor/common/calibration/subdir.mk:20: wvendor/common/calibration/calibration.o] Error 127

make: ***|[vend0rﬁc0mmonf5ubdir.mk:23: vendorfconmonfplic_isr.D] Error 127

make: *** [drivers/lib/src/pke/subdir.mk:41: drivers/lib/src/pke/eccp curve.o] Error 127

make: **%#% [vendorﬁUART_DEMOfsubdir.mk:&O: vendorfUART_DEMOfmain.o] Error 127

make: **%% [vendorﬁUART_DEHOHsubdir.mk:33: vendorﬁUﬁRT_DEHO!app_dma.D] Error 127

make: **% [vendor;"UART_DEHO,-"s‘;bdir.rr.k:26: vendor;"UﬁRT_DEHO!app.o] Error 127

Invoking: GNU RISC-V Cross C Compiler

Figure 10.1: Error127

This issue is caused by the incorrect setting of the build tool version, setting the correct build tool version
would fix this problem.

10.2 Not found make in PATH or nothing to build when building

These problems are normally caused by importing the Telink RDS IDE format projects to Telink loT studio
directly without converting.

To resolve this problem, remove the project and convert it to Telink IoT studio before importing.

10.3 Orphaned configuration and no options on Settings tab

When this occurs, the properties of the project would be like the following:
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T! Properties for B91_Driver_Demo

| Settings

Resource
Builders

w CfC++ Build

Build Variables

Environment

Logging

Settings

Tool Chain Editar
C/C++ General
Linux Toals Path
Project Matures
Project References
Run/Debug Settings
Task Tags
TC32 Loader
Validation

Configuration: |UART Demo [ Active ]

| & Orphaned configuration. No base extension cfg exists for config.nds32le-elf-mculib-v5.exe.debug.28004847.1438473168.105987010

i Tool Settings M Devices [ Container Settings # Build Steps

Build Artifact Binary Parsers @ Error Parsers

Figure 10.2: Orphaned configuration

This problem is caused by the same reason as previous FAQ, converting Telink RDS format project before
importing it.

10.4 How to verify the current used toolchain gcc version for TLSR9

Users can set the following command to post command in project properties:
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T Properties for BA1_Driver Demo

|| Settings
» Resource
Builders . ;
v C/C++ Build Configuration: |UART Demo [ Active ] ~ (1

Build Variables

Environment :
O Container Settings " Build Steps Build Artifact Binary Parsers

Logging
S=liis Pre-build steps
Tool Chain Editor
Command:
» CfC++ General
Git
Linux Tools Path Description:
Project Natures
Project References
RISC-V Toolchains Paths Post-build steps
Run/Debug Settings Command:
Task Tags riscv32-elf-gec -v
TC32 Loader
. Validation Description:
WikiText

Figure 10.3: GCC version setting in Post command

Then build the project, the console will output the GCC version:
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[2! Problems & Tasks & Console ¥ [ Properties =3 Progress + Search

CDT Build Console [B92_Driver_Demo]
bs3s sl:&1.1 i} 41 1o DBy laet GP1lU_lemo.elt

x| & 4[5 & EE

@ MmBE~-o~= 18

~
Finished building: GPIO_Demo.siz
Finished building: GPIO_Demo.bin
Finished building: GPIO_Demo.lst
riscv32-elf-gcc -v
"/eygdrive/c/TelinkIoTStudio/RD _\.-’5.1.2/ oolchains/nds321e-elf-mculib-v5f/bin/riscv32-elf-gcc.gnu™ "-v"
Using built-in specs. -
COLLECT_GCC=/cygdrive/c/TelinkIoTStudio/RDS/V5.1.2/toolchains/nds321e-elf-mculib-v5f/bin/riscv32-elf-gcc.gnu
COLLECT_LTO_WRAPPER=/cygdrive/c/TelinkIoTStudio/RDS/V5.1.2/toolchains/nds321le-elf-mculib-v5f/bin/../libexec/gcc/riscvi2-
elf/10.3.08/1to-wrapper.exe
Target: riscv32-elf
Configured with: /home/sqa/Jenkins/workspace/build-system-3/source-packages/gcc-10.3.8-riscv-ast-v5 1 8-branch/configure
--target=riscv32-elf --prefix=/home/sqa/Jenkins/workspace/build-system-3/toolchain/nds32le-elf-mculib-v5f --with-
pkgversion=2023-06-30_nds32le-elf-mculib-v5f-8376cb5a7ad --disable-nls --enable-languages=c,c++ --enable-1to --with-
gmp=/home/sqa/Jenkins/workspace/build-system-3/host-tools --with-mpfr=/home/sqa/Jenkins/workspace/build-system-3/host-
tools --with-mpec=/home/sqga/Jenkins/workspace/build-system-3/host-tools --with-isl=/home/sqa/Jenkins/workspace/build-
system-3/host-tools --with-cloog=/home/sqa/Jenkins/workspace/build-system-3/host-tools --without-zstd --with-
arch=rv32imfcxandes --with-tune=andes-25-series --enable-0Os-default-ex9=yes --enable-gp-insn-relax-default=yes --disable-
tls --with-libc=mculib --with-abi=ilp32f --disable-libsanitizer --disable-werror --enable-multilib=yes --with-multilib-
list=dsp,no-fma,andesd45 --with-newlib --disable-shared --enable-threads=single --with-
headers=/home/sqa/Jenkins/workspace/build-system-3/toolchain/nds321e-elf-mculib-v5f/riscv32-elf/include CFLAGS="-02 -g -
Wno-implicit-fallthrough -Wno-int-in-bool-context -Wno-cast-function-type' CXXFLAGS='-02 -g -Wno-implicit-fallthrough -
Wno-int-in-bool-context -Wno-cast-function-type' CC=/home/sqa/Jenkins/workspace/build-system-3/host-tools/bin/gcc.exe
CXX=/home/sqa/Jenkins/workspace/build-system-3/host-tools/bin/g++.exe LD=/home/sqa/Jenkins/workspace/build-system-3/host-
tools/bin/1d.exe AR=/home/sqa/Jenkins/workspace/build-system-3/host-tools/bin/gcc-ar.exe
RANLIB=/home/sqa/Jenkins/workspace/build-system-3/host-tools/bin/gcc-ranlib.exe NM=/home/sqa/Jenkins/workspace/build-
system-3/host-tools/bin/nm.exe --enable-checking=release LDFLAGS=--static 'CFLAGS_FOR_TARGET=-02 -g -mstrict-align’
'CXXFLAGS_FOR_TARGET=-02 -g -mstrict-align' LDFLAGS_FOR_TARGET=
Thread model: single
Supported LTO compression algorithms: zlib
gce version 10.3.0 (2023-06-30_nds32le-elf-mculib-v5f-8376ch5a7ad)
99:54:10 Build Finished. @ errors, @ warnings. (took 6s5.331ms)
W
Figure 10.4: Verify the GCC version
10.5 How to verify current used make tools
Users can set following command ( echo "${PATH}" ) to post command in project properties:
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*| Properties for B93 Driver Demo O >
type filter text Settings - ~ 8
Resource
Builders ] : .
v C/C++ Build Configuration: |N22_Test Demo [ Active ] ~ | Manage Configurations...

Build Variables

Environment

Lagging 4 Build Steps Build Artifact Binary Parsers €3 Error Parsers I
Settings Pre-build steps
Tool Chain Editor
Command:
C/C++ General
Git | V‘
Linux Tools Path Description:
Project Natures | V‘
Project References
RISC-V Toolchains Paths Post-build steps
Run/Debug Settings Command:
Task Tags [echo *${PATH)" v
TC32 Loader
Validation Description:
WikiText [ v|

Figure 10.5: Make tool setting in Post command
Then build the project, the console will output the path that the first one is the make tool path:

@i Problems = Tasks & Console % [ Properties
CDT Build Console [B93_Driver Demo]

text code urndatg data bss dec hex filename
8528 b7 2 448 37 68 BB17 19d9 N22 _Test Demo.elf

Finished building: N22 Test Demo.siz
Finished building: N22_Test Demo.lst

echo "C:\TelinkIDE\RDcygwin\bin;[:\TelinkIDE‘\RDS\VB.2.3\tnolchains\nds321&—el'F—mculih—
vShbin;C:/TelinkIDE//plugins/org.eclipse. justj.openjdk. hotspot.jre.full.win32.x86_64 17.8.2.v20220201-
1288/jre/bin/server;C: /TelinkIDE//plugins/org.eclipse. justj.openjdk.hotspot. jre.full.win32.x86_64 17.8.2.v
\system32;C:\Windows; C: \Windows\System32\Wbem; C: \Windows\System32\WindowsPowershelliwl. 8% ;C: \Windows\Syste
‘\Applatailocal \Microsoft\WindowsApps; ;C:\WsershadminAppDatailocal\WProgramsi\Microsoft WS Codelbin;C:\Telin
C:4\TelinkIDENRDSYWS. 2. 3 eygwinibin;C:\TelinkIDEVRDSYS. 2. 3\toolchainsinds321e-elf-mculib-vShbin; C: /TelinkT
1288/jre/bin/server;C: /TelinkIDE//plugins/org.eclipse. justj.openjdk.hotspot. jre.full.win32.x86_64 17.8.2.v
‘\system32;C:\Windows ; C: \Windows\System32\wbem; C: WWindows\System32\WindowsPowerShellhwl. 8% ;C: \Windows\Syste
“AppData\Llocal\Microsoft\WindowsApps;;Ci\Usershadmin\AppDatatlocal\Programs\Microsoft W5 Code\bin;C:\Telin

15:18:23 Build Finished. @ errors, 31 warnings. (took 7s5.458ms)
Figure 10.6: Verify the make tool path

In the above example result, the make tool pathis C:\TelinkIDE\RDS\V3.2.3\cygwin\bin with base
version V3.2.3 .
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10.6 The permission error occurred while opening the Telink TC32
console

Cmder Launcher >

Failed to copy vendor/conemu-maximus5/ConEmu.xml file to
config/user-conemu.xml! Access Denied.

Lo

Figure 10.7: Permission problem

The user should open Telink TC32 console with the privileges of administrator .

10.7 How to enable case sensitivity feature on Windows OS

On the Windows OS, by default, file names are not case sensitive. For example, when you have a header file
name of app.h and another file name of App.h , by default, Windows cannot distinguish them correctly.
If you need to enable case sensitivity, you can use the following methods.

Firstly, you need to enable WSL:

g =sEE > BT

SFFFOIThEE

W ssies | @ mmeeem Windows I8 | EESEswEH
ETALEAS Windows BSHES | MASSES

T EMET

1o momnmesnsias

et

EEmE Windows Thag (7]

FEERWIEE, FEEESRE FEAAWEE. SEkESE
& ErhEE SRR R

[1 | Windows Process Activation Service ~
[ | windows Projected File System
[0 | Windows TIFF IFilter
[ windows ElilEEERFFE
] | fTERT RS
Ttesci=gEria
[ | 2% TcPIP B5(AD echo. daytime &)
O | |BkeEs
EATRE
BT Linux 8] Windows FEHK
LI =HiFs
TEESTEE AP 25

Figure 10.8: Enable WSL
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Then, open Windows PowerShell as an administrator and navigate to the directory you need to use, and
execute the following command:

(Get-ChildItem -Recurse -Directory).FullName |
ForEach-Object {fsutil.exe file setCaseSensitiveInfo $_ enable}

11 Known issues

11.1 Save button is disabled at the first time
Use the Ctrl+S or menu item File -> Save , or click the Save All button/menu-item or use
Ctrl + Shift +S . The save button would become enabled state in the following modifications.

This is caused by Telink Formatter plugin.

11.2 loT Studio exits if users click the Open artifact path multiple
times

This occurs in that the 10T Studio cannot find the artifact path. Users should avoid clicking the toolbar icon
Open artifact path multiple times in a short time.

11.3 loT Studio will block for a while after importing project and
changing toolchain

This is a normal case as the loT Studio would take a while to do the code indexing and scan compiler files

(for example the toolchain system header files and directories).

This procedure would take a few seconds. Users should wait for this job done before other operations (eq:
building). This is @ one-shot action, it will happen on toolchain changing settings or importing projects.

11.4 The size of generated artifacts are zero

This issue will occur if users start to build a configuration when the project is just imported and the makefile
hasn’t been generated fully.

When this happens, a log similar to the following example would display on the console log window:
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riscv32-elf-gcc —-mcmodel=medium -mcmodel=medium —02 —fmessage-length=0 —ffunction-sections
—-fdata-sections —flto -g3 -T ../boot.link -nostartfiles -Xlinker --gc-sections
-L"E:\TelinkIDE\[Src]telink_eagle_ble_multi_connection_src\B91_ble_multi_conn_src\algorithm\lc3"
-Wl,-Map, "B91_demo.map" -g3 -mcpu=d25f -ffunction-sections -fdata-sections -fmessage-length=0
=fno-builtin —fomit-frame-pointer -fno-strict-aliasing —-fshort-wchar -fuse-ld=bfd —fpack-struct
-02 -0 "B91_demo.elf" ./vendor/common/hci_transport/hci_dfu.o

. /vendor/common/hci_transport/hci_dfu_port.o ./vendor/common/hci_transport/hci_h5.o

. fvendor/common/hci_transport/hci_slip.o ./vendor/common/hci_transport/hci_tr.o

. /vendor/common/hci_transport/hci_tr_hd.o ./vendor/common/hci_transport/hci_tr_h5.o

. /vendor/common/blt_common.o ./vendor/common/blt_fw_sign.o ./vendor/common/blt_led.o

. /vendor/common/blt_soft_timer.o ./vendor/common/commen_dbg.o ./vendor/commeon/custom_pair.o

. /vendor/common/device_manage.o ./vendor/common/flash_fw_check.o ./vendor/common/simple_sdp.o

. /common/tl_queue.o ./common/utility.o -1lm -ldsp
[/cygdrive/d/TelinkIDE/RDS/V3.2.3/toolchains/nds321le-elf-mculib-v5f/bin/ .. /lib/gee/riscv32—-elf/7.4.0/
A friscv32-elf/bin/1d.bfd: warning: cannot find entry symbol _RESET_ENTRY; defaulting to
0E00EAEA200000008

Finished building target: B91_demo.elf

Invoking: GNU RISC-V Cross Create Flash Image
Invoking: GNU RISC-V Cross Create Listing
Invoking: GNU RISC-V Cross Print Size
riscv32-elf-objcopy -0 binary "B91_demo.elf" "B91_demo.bin"
riscv32-elf-size "B91_demo.elf"
riscv32-elf-objdump --source --all-headers --demangle --line-numbers --wide "B91_demo.elf" =
"B91_demo.lst"
text code rodata data bss dec hex filename
9] ] <] 2] [3] ] 8 B91_demo.elf

Figure 11.1: Artifact size is O

To resolve this problem, users should wait a few seconds then build the configuration again.

To avoid this issue, users should wait for the makefiles to be generated and the indexing to be finished. The
process can be viewed at the right bottom of the loT Studio:

T Telink W5 _N22 - Telink IDE - O X

Elle Edit Source Refactor Mavigate Search Project Run T Telink Window Help

il | B-R - B% | B BN G-8-F-C-H-0-0-G-'® ¢~
b - - I = v| # Q E,}| ]
75 Project Explorer = 8 = 08 gEo x| = 8 :
BES YV § :
» leg B9 Driver Demo (in B91) [te There is no active editor
> (o B92 Driver_Demo (in B92) [te that provides an outline.

> Izg = B93 Driver_ Demo (in B93) |

[*] Problems ¥ Tasks B Console X O Properties = bf %ﬂl 8-> = 8
Eclipse Embedded CDT CMSIS Packs console

T_,-_—g B93 Driver Demo Discover compiler bui..ttings: (64%) WM = R ]

Figure 11.2: |oT Studio is busy
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11.5 Clicking the telink menu is invalid

This issue will occur if users do not select any project. To avoid this issue, select a project before clicking

the telink drop-down menu.

11.6 The problem that the source file cannot be found in debugging

In the process of debugging, there may be an error that the source file cannot be found. At this time, click

Edit Source Path... , as shown below:

[£ main.c l¢ app_dma.c  [Elmain_loop() at app_dma.c:136 0x20008514 X

Can't find a source file at
"feygdrive/c/Users/wf_15/Documents/telink_b31m_driver_sdk/demo/vendor/UART_DEMO/app_dma.c”
Locate the file or edit the source lookup path to include its location.

View Disassembly...

Locate File...

Edit Source Lookup Path...

Configure when this editor is shown | Preferences...

B Console x ¥ Registers [2! Problems @ Executables & Debugger Console O Memory
CDT Build Conscle [B91_Driver Demo]
11:11:15 **** Incremental Build of configuration UART Demo for project B9l Driver Demo *¥**
make -3j8 all
Invoking: GNU RISC-V Cross Print Size
riscv32-elf-size "UART_Demo.elf"
text code rodata data bss dec hex filename
35246 35230 16 268 672 36186 8d5a UART_Demo.elf
Finished building: UART Demo.siz

11:11:15 Build Finished. @ errors, © warnings. (took 29@ms)

Figure 11.3: locate

T B e-va. X %Br. 7Ex. =M. ZDi. %Pe. ZPe. ~ 8
et 3

Name Type Value
X| ¢ o ElEFEE&E By =0

Then follow the instructions in Chapter Edit Path Mapping to configure path mapping

12 loT Studio settings

12.1 Hide print margin

The print margin will show in default, which is a vertical line in the code editor:
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BH G-~ ~-F-H~-0-"E- Q- @y~ JF[E T
[€ dbgporte x

—I/........Huuuu.........H.Luuu.........uuuuu........Huuuu...

2 @file dbgport.c

4 @brief This is the source file for BS%1lm

5

6 Driver Group

7 2019

] @par Copyright (c) 2019, Telink Semiconductor (Shanghai) Co., Ltd.
10 211 rights reserved.
12 Licensed under the &pache License, Version 2.0 (the "License"):
13 vou may not use this file except in compliance with the License.
14 You may obtain a copy of the License at

-
=

i

*

k

o

("TH

e [

L IE]

|_:-_ Problems | Tasks B Conscle % [] Properties
P

Figure 12.1: Print margin in text editor

If you want to hide it, you can uncheck the Show print margin option
preferences.

on the

= B8

i ey R R R

Text Editors page of

T Preferences O X
type filter text Text Editors A= - 8
v General Displayed tab width: 4
> Appearance ] [ Insert spaces for tabs
C Pat
Con:patr:_f = Remove multiple spaces on backspace/delete
ontent Types o .
v Editors @ Highlight current line
! Autosave I 8 show print margin I
| File Associations Print margin column: 80
Large File Associ [ Allow editors to override the margin column
» Structured Text [ TErr e e
v Teat Editors B Show cursor position in the status line
bil P
A _—
ceesst . ity B show selection size in the status line
A tat
nnotations
Hyperlinking 8 show range indicator
Linked Mode () Show whitespace characters (configure wisibility
Quick Diff B show affordance in hover on how to make it sticky
Spelling When mouse moved into hover: Enrich after delay
nable drag an rop of text
lLT""'TE"‘ el s ey il i o
Globalization
arn before editing a derived file
‘ 8 Warn bef diting a derived fil
€ys e \
Link Handlers B Smart caret positioning at line start and end
5 Metwork Connectio Show code minings for problem annotations: Mone e
Figure 12.2: Configure the print margin
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13 loT Studio Debug Tool For TLSR9

Note: This jtag debug tool is only used for TLSR9 series chips

13.1 Build debuggable programs

To use the debugging function, when building an executable file, add the -g option to the compilation
options, and pay attention to check the compiler and linker parameters, and delete all the -O options.

And the optimization option should be selected as -Og, and cannot be set to -O0, because in the test, it
is found that the program compiled with the -O0 option cannot run normally after downloading, and the
following error will occur when trying to download again:

Logging: <== Jtag Burn || ICEMan ==>
option<i, image> para<C:\Users\DELL\Desktop\wks\telink b91m_driver_src\project\tisr risc\B92\GPIO_Demo\GPIO_Demo.bir  Args:[C:\TelinkloTStudio\RDS\V5. 1. 1\ice\ICEman.exe, -Z, v5, -b, 2354]

option<a, addr> para<0x0> Andes ICEman (OpenOCD) 5.1.1-g3a34fc9 (2022-04-22-14:27)
option<b, port> para<2354> Burner listens on 2354

option<r, reset-and-run> para<(null)> Telnet port: 4444

option<v, verify> para<(null)> TCL port: 6666

option<c, chip> para<B92> Andes AICE-MINI+

option<t, telnet_port> para<4444> JTAG frequency 10.000 MHz

J t a B urn There is 1 core i tap
Attempting to connect to 127.0.0.1, port 2354 The core #0 listens on 1111, I I I a n

Socket call with family: 2 socktype: 1, protocol: 0 ICEman is ready to use.

dmstatus =0x00430ca2

Connect successfull! hardware reset-and-hold success on [nds.tap] hart 0
Attempting to connect telnet server, ip<127.0.0.1>, port<4444> <-- Unable to halt [nds.tap] hart 0 -->
Connect successful! dmcontrol=0x00000001
dmstatus =0x00430ca2
1t inb: Burning failed due to target errors. 1t [<- Unable to halt [nds.tap] hart0 —>
SPI_Burn exited with code:0 dmcontrol=0x00000001

Figure 13.1: Jtag Burn err

In the process of building the program, you may encounter syntax errors like the one shown in the figure
below. The solution is to delete options such as -Wall -Werror of the compiler (also pay attention to checking
the parameters of assembler and linker):
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§& Telink ~ 11838 15:55

Telink - B91_Driver_Demoj/vendor/UART_DEMO/app.c - Telink IDE
File Edit Source Refactor Navigate Search Project Run ¥ Telink Window Help

[mlhg w8 % i T S B 0O~ &~ g B P e [n:d Q B B
& ProjectExplorer x = & %W & = 8 [@main.c [Eapp.c x = B ®-Variables % Breakpoi x % Expressio %.Periphera = 8
~ & B91_Driver_Demo (in B91) ﬁj L= s L) & w BEE% N 3
» i Binaries 115 #alif/ EIOW CTD —— 1ICE DTEA
» i Includes B Console x [ Problems © Executables [J Debug Shell & Debugger Console X & 4|5 LEEE & mB-v =0
» @mboot CDT Build Console [B92_Driver_Demo]
} Gz common 53 | gpio_output_en(gpio_swm);
» e drivers | eannnand
b calink /home/wang/Telink/telink b91m driver src/chip/B92/drivers/lib/src/swire.c:54:19: error: implicit conversion from 'swm pin e' to 'gpio_pin e' [-Werror=ent
» & UART Demo 54 | gpioifunctionien(gpioiswm);
» e vendor /home/wang/Telink/telink b91m driver src/chip/B92/drivers/lib/src/swire.c:58:22: error: implicit conversion from 'swm pin e' to 'gpio_pin_e' [-Werror=ent
» & 3rd-party 58 | gpio_set_low_level(gpio_swm);
Backup_before_convert_.cproject | A -
~ #£B92_Driver_Demo (in B92) /home/wang/Telink/telink b91m driver src/chip/B92/drivers/lib/src/swire.c:60:23: error: implicit conversion from 'swm pin e' to 'gpio pin e' [-Werror=ent
» @l Includes 60 | gpio_set_high level(gpio_swm);
» czboot | [——
» G common /home/wang/Telink/telink_b9lm_driver_src/chip/B92/drivers/lib/src/swire.c:62:22: error: implicit conversion from 'swm pin_e' to 'gpio_pin_e' [-Werror=ent
) sa drivers 62 | gploisetilowilevel(gploiswm);
> o li
@link /home/wang/Telink/telink_b91m driver_src/chip/B92/drivers/lib/src/swire.c:64:23: error: implicit conversion from 'swm_pin_e' to 'gpio_pin_e' [-Werror=ent
* & UART_Demo 64 | gpio set high level(gpio swm);
» ¢ vendor |
» i B93_Driver_Demo (in B93) /home/wang/Telink/telink b91m driver src/chip/B92/drivers/lib/src/swire.c:67:22: error: implicit conversion from 'swm pin e' to 'gpio_pin e' [-Werror=ent

67 | gpio_set_high_level(gpio_swm);

/home/wang/Telink/telink _b91m driver src/chip/B92/drivers/lib/src/swire.c:71:22: error: implicit conversion from 'swm_pin_e' to 'gpio pin e' [-Werror=ent

71 | gpio_set_low_level(gpio_swm);
| e ~
/home/wang/Telink/telink b91lm driver src/chip/B92/drivers/lib/src/swire.c:73:23: error: implicit conversion from 'swm pin e' to 'gpio pin_e' [-Werror=ent
73 | gpio_set_high level(gpio_swm);

/home/wang/Telink/telink b9lm driver src/chip/B92/drivers/lib/src/swire.c: In function 'swire set swm en':
/home/wang/Telink/telink b91lm driver src/chip/B92/drivers/lib/src/swire.c:88:16: error: implicit conversion from 'swm pin e' to 'gpio pin e' [-Werror=sent
5 B92_Driver_Demo

type filter text Settings H
» Resource
Builders
~ C/C++Build ®Tool Settings & l o A o
Bui?d Variables mssor
Eg\gll;'?nngment EOptimization
&Warnings
Tool Chain Edit Debugging h=0 -fomit-frame-pointer -fno-strict-aliasing -fshort-wchar -Fuse-ld=bfd I ETE I e R A T IR [ ird-std=c99 -Wno-gnu-zero-variadicmacro-arguments -fp
+ C/C++ General ~ ® GNU RISC-V Cross Assembler
(& Preprocessor

Linux Tools Path
» MCU

Project Natures

Project Reference

@Includes
EWarnings
EMiscellaneous

Run/Debug Settit ~ ® GNU RISC-V Cross C Compiler delete them
Task Tags EPreprocessor
TC32 Loader Sincludes
» Validation 2 Optimization
WikiText EWarnings

& Miscellaneous

~ ® GNU RISC-V Cross C Linker
EGeneral
@Libraries
EMiscellaneous

~ ® GNU RISC-V Cross Create Flash Image
@General

~ ® GNU RISC-V Cross Create Listing
@General

~ ® GNU RISC-V Cross Print Size
&General

@ Cancel
Figure 13.3: delete option
One thing to note is that when building the V5.1.2 N22 program, because of the tool chain, when using

the GCC 10 version of the N22 tool chain, delete the -mabi=ilp32f option (also pay attention to check the
parameters of assembler and linker).
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type filter text Settings
» Resource
Builders
~ C/C++Build
Build Variables
Environment
Logging
Tool Chain Edit
» C/C++ General
Linux Tools Path
» MCU
Project Natures
Project Reference
Run/Debug Settir

®Tool Settings ®Toolchains MWDevices

&Target Processor
@@ Optimization
EWarnings
#Debugging
~ ® GNU RISC-V Cross Assembler
(EPreprocessor
&Includes
EWarnings
@Miscellaneous
~ ® GNU RISC-V Cross C Compiler
(#Preprocessor

Task Tags
TC32 Loader Zincludes

» Validation @Optln?lzatlon
WikiText BWarnings

#Miscellaneous

~ ® GNU RISC-V Cross C Linker
&General
(ELibraries
EMiscellaneous

~ ® GNU RISC-V Cross Create Flash Image
=General

~ % GNU RISC-V Cross Create Listing
EGeneral

~ ® GNU RISC-V Cross Print Size
(=General

13.2 Burn program

BContainer Settings #Build Steps

Generate assembler listing (-Wa,-adhlns="$@.lst")
Save temporary files (~save-temps Use with caution!)
Verbose (-v)

Build Artifact @ Binary Parsers @Error Parsers

Other compiler flags | -mext-dsp FFISEIRER; -c -fmessage-length=0 -fomit-Frame-pointer -Fno-strict-aliasing -Fshort-wchar -Fuse-ld=bfd -std=c99 -Wno-gnu-ze

Support ANSI Programs, same as RDS (-§wsi)
Code Coverage, same as RDS (~coverage)
Apply HW DSP options(-mext-dsp)

delete it

Figure 13.4: delete_mabi

Apply and Close

When burning the program, pay attention to burner’s path and chip type, and then click Start ICEman. After
ICEman is ready, the telnet_port and burner_port should be consistent with ICEman’s, then click Burn, as

shown below:

Flashing Drivers and ICEMan 2

Jtag_Burn utility Path | CA\TelinkioTStudio\RDS\V3.2.3\flash\Jtag_burn.exe SelectJtag_bum_ | v

ICEMan exe/ELF [HinkoTStudio\RDS\V5.1.2\ice\ICEman.exe | Select ICEMan MCU Architecture: [v5 V]
Flashing Image/Binary and Other ICEMan
[r_sre\projectitisr_riscv\B92\GPIO_Demo\GPIO_Demo.bin | [selectimage Programming Start Address: [ox0
Other ICEMan Arguments:
Target management ICEMan/SPI_burn Host: [127.0.0.1 Bunner Port: [2354
Target Burn
[ Enable target burn Target burn image: Selectimage
Jtag_burn Driver Arguments ICEMan Interface cfg 3
Target Chip: [892 v |r|ash Controller Addiress: | Misc Arguments:
Verification [TErase All [Junlock [JLock after burn Reset and Run [] Encrypt
[JICEMan Interface Config: | v] | Telnet Port: 4444 ] | 5
Logging: <== Jtag_Burn || ICEMan ==>
>> Flash page program at address 0x000400 A || ---- Start the ICEMan at: 2023-08-28 10:44:45--—-
>> Flash page program at address 0x000800 Args:[C:\TelinkloTStudio\RDS\V5. 1.2\ice\ICEman.exe, -Z, v5, -b, 2354]
>> Flash page program at address 0x000c00 Andes ICEman (OpenOCD) 5.1.1-g3a34fc9 (2022-04-22-14:27)
>> Flash page program at address 0x001000 Burner listens on 2354
>> Flash page program at address 0x001400 Telnet port: 4444
>> Flash page program at address 0001800 TCL port: 6666
>> Flash verify ok at address 0x000000 Andes AICE-MINI+
>> Flash verify ok at address 0x000400 JTAG frequency 10.000 MHz
>> Flash verify ok at address 0x000800 There is 1 core in tap
>> Flash verify ok at address 0x000c00 The core #0 listens on 1111.
>> Flash verify ok at address 0x001000 ICEman is ready to use.
>> Flash verify ok at address 0x001400 hardware reset-and-hold success on [nds.tap] hart 0
>> Flash verify ok at address 0x001800
>> File download to flash success at address 0x00000000: 6916 bytes Stopped the ICEMan at: 2023-08-28 10:48:04-----
>> MCU reset and run
SPI_Burn exited with code:0
S

< >

1

Start ICEMan before burning Start ICEMan

Figure 13.5: Jtag burn
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Jtag_ Burn is located in the SloTStudio_PATH/RDS/V3.2.3/flash/directory, and its help documents are also
in the same directory.

13.3 Telink ICEman GDB Debugging (Recommended)

Before starting debugging, you must ensure that the elf file you want to use is selected, as shown in the
figure.
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Tl whks - Telink loT Studio

File Edit Source Refactor Mavigate Search Project Run Telink W
Or-HR &-F~-R-BBi% eSS BEIQ
& Project Explorer =S e

v g5 = B93 Driver_Demo (in B93) [telink_b91m_driver_src master]
> 3% UART_Dema.elf - [riscv/le]
SR Tnchudes
» g boot
» [y common
» g drivers
» g link
» = UART Demo
» jip vendor

Figure 13.6: Select ELF

Then click the drop-down arrow of the Debug icon on the toolbar and select Debug Configuration.
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[

W

Q-0 ~-Q~ 9~

[t] 1B92 Driver Demo UART De

-

Debug As
Debug Configurations...

Organize Favorites...

o

Figure 13.7: debug

Double clicking on Telink ICEMan GDB Debugging, and a default debug configuration will be generated. You
can choose whether you need an ICEman interface in the Debugger tab, as shown in the figure.

Create, manage, and run configurations

FeRXEY -

[type filter e

[E] C/C++ Application
[E] C/C++ Attach to Application
[E] C/C++ Container Launche:
[E] C/C++ Postmortern Debugger
[E] C/C++ Remote Application
Gij C/C++ Unit
[&] GDB Hardware Debugging
[&] GDB OpenOCD Debugging
[£] GDB PyOCD Debugging
[2] GDB QEMU Debugging
[2] GDB SEGGER J-Link Debugging
[E] GDB TC32 T-Link Debugging
£ Launch Group

v [2] Telink ICEMan GDB Debugging

[£] UART Demo

Filter matched 15 of 15 items

®

Demo J
,{m b Startup| % Source| [T Common . SVD Path
Setup =
HAstart ICEMan locally
Executable path: [sticeman \ path}$(iceman_executable} Browse...| | Variables.
Actual executable: DS\V5.1.2\ice\ICE
o ferences pages or the project properties page)
[JICEMan Interface Config : | aice sdp.cfg <
GDE port: ]
Telnet port:
Zvs ‘
Allocate console for ICEMan Allocate console for the telnet connection
GDB Client Setup
[AStart GDB session
Executable name: | ${cross_prefixigdbs(cross_suffix) Browse...| | Variables.
Actual executable: riscv32-elf-gdb ]
Other options: | ]
Comman ds: ‘ ‘
Remote Target v
Revert Apply
Debug clo:

Figure 13.8: ICEman interface

13.4 View peripheral registers through SVD file

Users can select the correct chip type in the SVD tab, and the IDE will find the required SVD file on its own.
Users can also customize the path of SVD files, but it is not recommended.
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Name: TL_PLATFORM_SDK_721X UART_Demo

Main|# Debugger & Startup & Source|D Commor|[% SVD Path| |
SuD file (used hy the peciphecal regisrecsviewer mayhe syd zip)
Chip: TL721X

Custom file path Browse...| Variab

Figure 13.9: SVD Tab

In the Debug view, users can select the peripherals they want to view through the Peripheral tab.

PSSO M BUA:FYOYrR @2V Iy ey QU I H | R
[¢ app.c x = B  «-Variables ® Breakpoin %I Expressio |Z. Peripheral x|% Peripheral = O
I e e e P §
2 * @file app.c
3 * Peripheral Address Description
LSI : @brief This is the source file for Telink RISC-V MCU 2 EOC 0x80140
6 * @author Driver Group 2 0x80140
9 * @par Copyright (c) 2019, Telink Semiconductor (Shanghai) Co., = 0x8014¢
e * Mo details to display for the current selection.
11 * Licensed under the Apache License, Version 2.0 (the "Lice
12 * you may not use this file except in compliance with the |
B Console i Registers (2! Problems @ Executables & Debugger Console O Memory x O =% % @~ § -0
Monitors ¢ % % % 12C 0x80140280 x |4 New Renderings...‘
i Address Value
T
i [2CSP 0x80140280 0x00305C1F
wi 12C_ID 0x80140281 0x0000305C
P 12CMST 0x80140282 0x44000030
b 12CSCTO 0x80140283 0x01440000
» i [2CSCT1 0x80140284 0x00014400
» W [2CTRIG 0x80140285 0x95000144
i 2CLEN 0x80140286 0x01950001
» i SLAVE_STRECH_CTRL 0x80140287 0x8A019500
» it 2C_DATA_BUFOQ 0x80140288 0xA18A0195
i [2C_DATA_BUF1 0x80140289 0x00A18A01
» i 12C_DATA_BUF2 0x8014028A 0x0000A18A
» i 12C_DATA_BUF3 0x8014028B 0x010000A1
» i [2C_BUFCNT 0x8014028C 0x00010000
b i [2C_STATUS 0x8014028D 0x1F000100
» i 12C_IRQ_STATUS 0x8014028E 0x5C1F0001
Writable Smart Insert 1:1:0

Figure 13.10: View Peripheral
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13.5 Breakpoint

At present, TLSR9 series SoC supports up to two hardware breakpoints. When you find that the starting
address of your program is Ox20000000, it means that it is running in flash and needs to use hardware
breakpoints. Commands such as step in or step over will use a breakpoint, so users can only customize
one breakpoint when debugging, otherwise an exception will occur.

When a3 cannot access memory at address xx exception occurs during debugging, you can use the
info br command to check the number of breakpoints.

14 Independent use of some tools in the loT Studio

14.1 Converter

The purpose of this tool is to convert the project file format of the original Telink RDS IDE to the current
Telink 10T Studio project format.

To use it on the command line, you should switch to the directory of the .cproject file that needs to be
converted, and executing S(converter_path)/TelinkRDS2IDE in this directory.

The directory where the converter is located is the SloTStudio_PATH/tools/Converter/.

For example:

fc/ 1.1/ice
$ cd /cygdrive/c/u /Des s Im_driver_src/project/tlsr_riscv/Bo1

ct/tlsr_riscv/B91

oject/tlsr_riscv/Bo.

Figure 14.1: converter cmd
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14.2 Jtag Burn

The function of this tool is to burn and write binary files into the TLSR9 chip. Before using it, you need
to first use ICEman. The Jtag Burn tool is located in the SloTStudio_PATH/RDS/V3.2.3/flash/, and the user
manual is also in this directory. The following is a example of usage:

./ Jtag_Burn --chip B92 -- reset- and- run --verify --addr @ -- image /home/wang/ UART_Demo.bin --
port 2354 --telnet_port 4444 --unlock

The parameter of --port and --telnet_port should be same with the parameter of ICEman’s Burner port and
telnet port. If you see the running results of ICEman indicating its Burner Port is 2354 and its telnet port is
4444 (as shown in the following figure):

Open On-Chi
Licensed under GNU GPL v2
For bug reports, read

http enocd.org/doc/d gen/bugs . html
Andes AICE-MINI+
1TAG frequency 10.000 MHz
There is 1 core 1in tap
The core #0 Tistens on 1111.
ICEman is ready to use.

Figure 14.2: ICEman defalut port

In this case, you can run the Jtag_Burn without --port and --telnet_port.

15 Installation and uninstallation of loTStudio in linux

15.1 Installation

In linux, run the installation program * Telink_IoT_Studio_xxxx_Installer.run “ to install the loTStudio.
You can give it executable permissions and run it. During the execution, the user needs to enter the instal-
lation path. Be sure to enter the absolute path, as shown in the figure below.
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-4.29M1-gtk-linux-x86_64.zip toolchain_linux-aarch64_riscv64-zephyr-elf.tar.gz Zigbee_SDK.zip
qt-unified-linux-x64-online.run Telink_IoT Studio_2623.8 Installer.run toolchain_linux 64_riscv64-zephyr-elf.tar.gz
release_tar_1.3.0_Telink_libusb BDT-linux-1.3.0.tar telink riscv linux toolchain.zip v2ray-linux-64.zip

$ chmod a+x Telink IoT_Studio_2023.8 Installer.run
$|./Telink IoT Studio 2023.8 Installer.run
i 100% ALl good.
Uncompressing TelinkIoTStudio for TC32 and RISC-V SoC 100%
Installing Telink IoTStudio for TLSR8 and TLSR9
Input a place as the destination location(use abosulte path):/home/wang/IDE2308
Destination is:/home/wang/IDE2308
AR A RS R S
Installing the IDE...
ko R ko Sk Rk R
Found the ide dir
Installing the files ...
3,482,592,247 99% 376.82MB/s 0:00:08 (xfr#24417, to-chk=0/26980)

sk K KK KK KRR SRk o sk K o K KKK K KR KRS S ko kK o K R KKK KR K o

Installing the launcher
T T HHAAAA K F KA KK H A KA A KA AR F KKK K HA A A A AK A

Handling launcher...
Version:2023.8

sk KKK KK KRR Sk o koK o K KKK KK R KRR SK S ok K R KKK KR K o

Applend the TC32 toolchain and other utilies path to PATH env to .profile:
*

sk KKK KK KRR Sk o koK o K KKK KK R KRR SK S ok K R KKK KR K o

Installation is almost done, extra actions are required to be done manually:
o A A A A KA A o KA KA o A K ok

Please run the following scripts/commands one by one manually to fini the setup:
sudo cp /home/wang/IDE 3 v i i rules /etc/udev/rules.d
cd /home/wang/IDE2308 ./ins i package.
cd /home/wang/IDE2308 ; . /change-udev -us

Figure 15.1: Installation

After the program execution ends, you need to execute the command given at the end of the program to
complete the installation.

\wang@wang-ASUS: $ sudo cp /home/wang/IDE2308/udev/99-libtlink.rules /etc/udev/rules.d/; cd /home/wang/IDE2308; sudo ./install linux_package.sh; cd /home/wang/IDE2
308/udev; sudo ./change-udev-usb-mode.sh

[sudo] password for wang

./install_linux_package.sh: line 9: $LISTFILE: ambiguous redirect

### Execute ICEman.sh ###

./install_linux_package.sh: line 14: cd: ice: No such file or directory

./install_linux_package.sh: line 15: ICEman.sh: No such file or directory

### Start to install additional linux packages ###
DISTRIB_ID=Ubuntu

DISTRIB_DESCRIPTION="Ubuntu 20.04.6 L
INAME="Ubuntu"

PRETTY_NAME="Ubuntu 20.04.6 LTS"
DISTRIB_DESCRIPTION="Ubuntu 20.04.6 L

PRETTY_NAME="Ubuntu 20.04.6 LTS"

'universe' distribution component is already enabled for all sources.
ignome-terminal has been installed.

build-essential has been installed.

z1iblg:i386 has been installed.

1ib32z1 has been installed.

libncurses5:1386 has been installed.
libncurses5 has been installed.
e2fslibs:1386 has been installed.
igcc-multilib has been installed.
g++-multilib has been installed.
libcanberra-gtk-module has been installed.
libgtk3-nocsd® has been installed.

change libusb MODE=666

restart udev

wang@wang-ASUS : £ |

Figure 15.2: Post of installation

15.2 Uninstallation

In the loTStudio installation directory, there is an uninstall.sh file that can be used to uninstall loTStudio.
You can give it executable permissions and run it. Users need to pass the path of loTStudio’s .desktop file
as a parameter to uninstall.sh. Note that there may be a TelinkloTStudio.desktop file in the installation
directory, do not use it as a parameter. You should use the .desktop file with the version number and you
can refer to the following example.

./uninstall.sh /home/wang/IDE2308/TelinkIoTStudio_2023.8.desktop
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wang@wang-ASUS: $ s
artifacts.xml SPI_Burn_chip_para.csv TelinkICE.desktop TelinkIoTStudio.desktop uninstall.sh

icon.xpm Telink.ico TelinkIoTStudio.ini version.csv
install_linux_package.sh Telink.cfg TelinkIoTStudio
notice.html TelinkICE 2023.8.desktop TelinkIoTStudio 2023.8.desktop
wang@wang-ASUS : $ chmod a+x uninstall.sh
wang@wang-ASUS : $ ./uninstall.sh /home/wang/IDE2308/TelinkIoTStudio 2023.8.desktop
Found the launcher:/home/wang/IDE2308/TelinkIoTStudio 2023.8.desktop
Exec: /home/wang/IDE2308/TelinkIoTStudio
Parse install dir:/home/wang/IDE2368
Found the installed file
Installation path is:/home/wang/IDE2308
Uninstall...Removing launcher...
Removing install dir...
done
wang@wang-ASUS : LY |

Figure 15.3: Uninstall

16 Docs for AndeSight

We have provided the relevant documents for AndeSight, which include the usage documents for Andes
Riscv toolchain and other tools. You can find them in the path below according to your needs.

« ${IoTStudio_Path}/doc/Andes_V323_doc/ : Docs for AndeSight V3.2.3
+ ${IoTStudio_Path}/doc/Andes_V512_doc/ : Docs for AndeSight V5.1.2
e ${IoTStudio_Path}/doc/Andes_V532_doc/ : Docs for AndeSight V5.3.2

17 How to compile loTStudio projects in the command line

If you want to compile loTStudio projects in the command line, you can refer to the following content.

Firstly, you need to build this project in loTStudio, and then a folder containing makefiles and compilation
results will be generated in the project directory, which is usually in the same directory as .cproject

Then open the shell of the toolchain that matches the project in Telink ->Toolchain Shell or ICEman Shell,
The example toolchain in the figure is V5.1.2 GCC10.3 V5F toolchain Shell
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wn | ¥ Telink Window Help

M B Telink RDS to IDE Converter O~~~ ® ¢~ - - - - | =
E [, Telink loT5tudio to Cmake kX
B Windows BDT (SWS and Jtag)
r

ter] Jtag Burn (SPI Burn) | P P T T S TE T T S SR S S TS
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ter]

Console % [ Properties =g Progress
Ly Projects and Artifacts shortcuts b
Toolchain Shell or ICEMan shell b Launch RISCV VSF(D25F) toolchain Shell (RDS 3.2.3 GCC 7.4) for TLSR9
@-LI Telink Links 5 Launch RISCV V3({N22) toolchain Shell(RDS V3.2.3 GCC 7.4) for TLSRY
Q Search on DocSite Launch RISCV V5F(D25F) toolchain Shell(RDS V¥5.1.2 GCC 10.3) for TLSR9

Launch RISCV V3{N22) toolchain Shell(RDS V5.1.2 GCC 10.3) for TLSR9
Launch RISCV VSF(D25F) toolchain Shell (RDS 5.3.x GCC 12.2) for TLSRO
Launch RISCV VS({N22) toolchain Shell (RDS 5.3.x GCC 12.2) for TLSRS
Launch ICEman Shell (V5.3.x) for TLSRS

Figure 17.1: select toolchain shell

Then jump the directory to the folder containing the makefile and execute make clean make all

Figure 17.2: make in shell
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